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CONTACT SAMSUNG WORLDWIDE

If you have any comments or questions regarding Samsung products, contact the Samsung customer care center.
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EL SALVADOR 800-6225 www.samsung.com/latin
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HONDURAS 800-7919267 www.samsung.com/latin
HONG KONG 3698-4698 www.samsung.com/hk

www.samsung.com/hk_en/
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EIRE 0818 717 100 www.samsung.com/ie

RUSSIA 8-800-555-55-55 www.samsung.ru

SINGAPORE 1800-SAMSUNG Www.samsung.com/sg
(726-7864)

SLOVAKIA 0800-SAMSUNG www.samsung.com/sk
(726-7864)

SOUTH AFRICA | 0860 SAMSUNG www.samsung.com/za
(726-7864)

SPAIN 902-1-SAMSUNG(902 172 | www.samsung.com/es
678)

SWEDEN 0771 726 7864 www.samsung.com/se
(SAMSUNG)

SWITZERLAND | 0848-SAMSUNG (7267864, | www.samsung.com/ch
CHF 0.08/min)

TADJIKISTAN 8-10-800-500-55-500

TAIWAN 0800-329-999 www.samsung.com/tw

THAILAND 1800-29-3232 www.samsung.com/th
02-689-3232

TRINIDAD & 1-800-SAMSUNG www.samsung.com/latin

TOBAGO (726-7864)

TURKEY 444 77 11 www.samsung.com/tr

U.A.E 800-SAMSUNG (726-7864) | www.samsung.com/ae
8000-4726

U.K 0845 SAMSUNG www.samsung.com/uk
(726-7864)

U.S.A 1-800-SAMSUNG www.samsung.com/us
(7267864)

UKRAINE 8-800-502-0000 www.samsung/ua

www.samsung.com/ua_ru

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com/kz_ru

VENEZUELA 0-800-100-5303 www.samsung.com/latin

VIETNAM 1 800 588 889 www.samsung.com/vn
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About this user’s guide

This user’s guide provides information about basic understanding of the
machine as well as detailed explanation on each step during the actual
usage. Both novice users and professional users can refer to this guide for
installing and using the machine.

This explanation is mainly based on the Microsoft Windows operating

system.

Some terms in this guide are used interchangeably, as below.

* Document is synonymous with original.

« Paper is synonymous with media, or print media.

The following table offers the conventions of this guide.

Finding more information

You can find information for setting up and using your machine from the

following resources, either as a print-out or onscreen.

Quick Install
Guide

.

Provides information on setting up your
machine and this requires that you follow
the instructions in the guide to prepare the
machine.

Convention Description Example

Bold Used for texts on the Properties
display or actual prints on
the machine.

Note Used to provide Note
additional information or The dgftfe fcf)rmat
detailed specification of may differ from
the machine function and country to country.
feature.

Caution Used to give users
information to protect the Do not touch the
machine from possible green underside of
mechanical damage or the toner cartridge.
malfunction.

Footnote Used to provide more a. pages per minute
detailed information on
certain words or a
phrase.

(See page | Used to guide users to (See page 1.1 for more

1.1 for the reference page for information)

more the additional detailed

information) | information.

Online User’s
Guide

Provides you with step-by-step
instructions for using your machine’s full
features, and contains information for
maintaining your machine,
troubleshooting, and installing
accessories.

This user’s guide also contains Software
section to provide you with information on
how to print documents with your machine
in various operating systems, and how to
use the included software utilities.

Note

You can access the user’s guide in other
languages from the Manual folder on the
printer software CD.

Printer Driver
Help

- il

Provides you with help information on
printer driver properties and instructions
for setting up the properties for printing. To
access a printer driver help screen, click
Help from the printer properties dialog
box.

Samsung website

If you have Internet access, you can get
help, support, printer drivers, manuals,
and order information from the Samsung
website, www.samsungprinter.com.



http://www.samsungprinter.com

Safety and Regulatory Information

Important Precautions and Safety Information
When using this machine, these basic safety precautions should always be
followed to reduce risk of fire, electric shock, and injury to people:

1 Read and understand all instructions.

2 Use common sense whenever operating electrical appliances.

3 Follow all warnings and instructions marked on the machine and in the
literature accompanying the machine.

4  If an operating instruction appears to conflict with safety information,
heed the safety information. You may have misunderstood the
operating instruction. If you cannot resolve the conflict, contact your
sales or service representative for assistance.

5  Unplug the machine from the AC wall socket before cleaning. Do not
use liquid or aerosol cleaners. Use only a damp cloth for cleaning.

6 Do not place the machine on an unstable cart, stand or table. It may fall,
causing serious damage.

7  Your machine should never be placed on, near or over a radiator,
heater, air conditioner or ventilation duct.

8 Do not allow anything to rest on the power cable. Do not locate your
machine where the cords will be abused by persons walking on them.

9 Do not overload wall outlets and extension cords. This can diminish
performance, and may result in the risk of fire or electric shock.

10 Do not allow pets to chew on the AC power or PC interface cords.

11 Never push objects of any kind into the machine through case or
cabinet openings. They may touch dangerous voltage points, creating a
risk of fire or shock. Never spill liquid of any kind onto or into the
machine.

12 To reduce the risk of electric shock, do not disassemble the machine.
Take it to a qualified service technician when repair work is required.
Opening or removing covers may expose you to dangerous voltages or
other risks. Incorrect reassembly could cause electric shock when the
unit is subsequently used.

13 Unplug the machine from the PC and AC wall outlet, and refer servicing
to qualified service personnel under the following conditions:

* When any part of the power cord, plug, or connecting cable is damaged
or frayed.

« If liquid has been spilled into the machine.
« If the machine has been exposed to rain or water.

« If the machine does not operate properly after instructions have been
followed.

« If the machine has been dropped, or the cabinet appears damaged.
« If the machine exhibits a sudden and distinct change in performance.

14

15

16

17

18

Adjust only those controls covered by the operating instructions.
Improper adjustment of other controls may result in damage, and may
require extensive work by a qualified service technician to restore the
machine to normal operation.

Avoid using this machine during a lightning storm. There may be a
remote risk of electric shock from lightning. If possible, unplug the AC
power for the duration of the lightning storm.

If you continuously print multiple pages, the surface of the output tray
may become hot. Be careful not to touch the surface, and keep children
away from the surface.

The Power cord supplied with your machine should be used for safe
operation. If you are using a cord which is longer than 2 m with 110 V

machine, then it should be 16 AWG' or bigger.
SAVE THESE INSTRUCTIONS.

* AWG: American Wire Gauge




Environmental and Safety Consideration

Laser Safety Statement

The printer is certified in the U.S. to conform to the requirements of DHHS 21
CFR, chapter 1 Subchapter J for Class I(1) laser products, and elsewhere, is

certified as a Class | laser product conforming to the requirements of IEC 825.

Class | laser products are not considered to be hazardous. The laser system
and printer are designed so there is never any human access to laser
radiation above a Class | level during normal operation, user maintenance, or
prescribed service condition.

Warning

Never operate or service the printer with the protective cover removed from
Laser/Scanner assembly. The reflected beam, although invisible, can
damage your eyes.

When using this product, these basic safety precautions should always be
followed to reduce risk of fire, electric shock, and injury to persons:

CAUTION - CLASS 3B LASER RADIATION WHEN OPEN
AVOID EXPOSURE TO THE BEAM.

DANGER - LASER RADIATION AVOID DIRECT
EXPOSURE TO BEAM.

DANGER - RADIATIONS INVISIBLES DU LASER EN CAS
D'OUVERTURE. EVITER TOUTE EXPOSITION
DIRECTE AU FAISCEAU.
VORSICHT - UNSICHTBARE LASERSTRAHLUNG, WENN
ABDECKUNG GEOFFNET,
NICHT DEM STRAHL AUSSETZEN.
ATTENZIONE - RADIAZIONE LASER INVISIBILE IN CASO DI
APERTURA. EVITARE LESPOSIZIONE AL FASCIO.
PRECAUCION - RADIACION LASER INVISIBLE CUANDO SE ABRE.
EVITAR EXPONERSE AL RAYO.
PERIGO - RADIAGAO LASER INVISIVEL AQ ABRIR. EVITE
EXPOSIGAO DIRECTAAO FEIXE.
GEVAAR - ONZICHTBARE LASERSTRALEN BlJ GEOPENDE
KLEP. DEZE KLEP NIET OPENEN.
ADVARSEL - USYNLIG LASERSTRALNING VED ABNING.
UNDGA UDSAETTELSE FOR STRALNING.
ADVARSEL. - USYNLIG LASERSTRALNING NAR DEKSEL
APNES. UNNGA EKSPONERING FOR STRALEN.
VARNING - OSYNLIG LASERSTRALNING NAR DENNA DEL
AR GPPEN. STRALEN AR FARLIG.
VAROITUS - NAKYMATONTA LASERSATEILYA AVATTAESSA.
VARO SUORAA ALTISTUMISTA SATEELLE.

E R -EIBTRILE MR R A
F 9 -0 HHE 2H o|xFol| =EE = U222

FOBHIAI,

Ozone Safety

During normal operation, this machine produces ozone.
The ozone produced does not present a hazard to the
operator. However, it is advisable that the machine be
operated in a well ventilated area.

If you need additional information about ozone, please
contact your nearest Samsung dealer.

California USA Only

This Perchlorate warning applies only to primary CR (Manganese Dioxide)
Lithium coin cells in the product sold or distributed ONLY in California USA.

Perchlorate Material - special handling may apply.
See www.dtsc.ca.gov/hazardouswaste/perchlorate.

Recycling

Please recycle or dispose of packaging materials for this
@ product in an environmentally responsible manner.

Correct Disposal of This Product (Waste Electrical
& Electronic Equipment)

(Applicable in the European Union and other European
countries with separate collection systems)

This marking shown on the product or its literature,
indicates that it should not be disposed with other
household wastes at the end of its working life. To prevent
possible harm to the environment or human health from
uncontrolled waste disposal, please separate this from

[ ] other types of wastes and recycle it responsibly to promote
the sustainable reuse of material resources.

Household users should contact either the retailer where they purchased this
product, or their local government office, for details of where and how they
can take this item for environmentally safe recycling.

Business users should contact their supplier and check the terms and
conditions of the purchase contract. This product should not be mixed with
other commercial wastes for disposal.

Radio Frequency Emissions

FCC Regulations

This device complies with Part 15 of the FCC Rules. Operation is subject to
the following two conditions:

+ This device may not cause harmful interference, and

+ This device must accept any interference received, including interference
that may cause undesired operation.

This device has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following
measures:

* Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

+ Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

+ Consult the dealer or an experienced radio/TV technician for help.



http://www.dtsc.ca.gov/hazardouswaste/perchlorate

Caution:

Changes or modifications not expressly approved by the manufacturer
responsible for compliance could void the user’s authority to operate the
equipment.

Canadian Radio Interference Regulations

This digital apparatus does not exceed the Class B limits for radio noise
emissions from digital apparatus as set out in the interference-causing
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry
and Science Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques
applicables aux appareils numériques de Classe B prescrites dans la norme
sur le matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par
I'Industrie et Sciences Canada.

United States of America

Federal Communications Commission (FCC)
Intentional emitter per FCC Part 15

Low power, Radio LAN type devices (radio frequency (RF) wireless
communication devices), operating in the 2.4 GHz/5 GHz Band, may be
present (embedded) in your printer system. This section is only applicable if
these devices are present. Refer to the system label to verify the presence of
wireless devices.

Wireless devices that may be in your system are only qualified for use in the
United States of America if an FCC ID number is on the system label.

The FCC has set a general guideline of 20 cm (8 inches) separation between
the device and the body, for use of a wireless device near the body (this does
not include extremities). This device should be used more than 20 cm (8
inches) from the body when wireless devices are on. The power output of the
wireless device (or devices), which may be embedded in your printer, is well
below the RF exposure limits as set by the FCC.

This transmitter must not be collocated or operation in conjunction with any
other antenna or transmitter.

Operation of this device is subject to the following two conditions:(1) This
device may not cause harmful interference, and(2) this device must accept
any interference received, including interference that may cause undesired
operation of the device.

Wireless devices are not user serviceable. Do not modify
them in any way. Modification to a wireless device will void

the authorization to use it. Contact manufacturer for service.

FCC Statement for Wireless LAN use:

“While installing and operating this transmitter and antenna
combination the radio frequency exposure limit of 1mW/cm2
may be exceeded at distances close to the antenna installed.
Therefore, the user must maintain a minimum distance of
20cm from the antenna at all times. This device can not be
colocated with another transmitter and transmitting
antenna.”

Declaration of Conformity (European Countries)

Approvals and Certifications

The declaration of conformity may be consulted at

www.samsung.com/printer, go to Support > Download center and enter your
printer name to browse the EuDoC.

The CE marking applied to this product symbolises
Samsung Electronics Co., Ltd. Declaration of Conformity
with the following applicable 93/68/EEC Directives of the
European Union as of the dates indicated:

January 1, 1995: Council Directive 73/23/EEC Approximation of the laws of
the member states related to low voltage equipment.

January 1, 1996: Council Directive 89/336/EEC (92/31/EEC), approximation
of the laws of the Member States related to electromagnetic compatibility.

March 9, 1999: Council Directive 1999/5/EC on radio equipment and
telecommunications terminal equipment and the mutual recognition of their
conformity.

A full declaration, defining the relevant Directives and referenced standards
can be obtained from your Samsung Electronics Co., Ltd. representative.

EC Certification

Certification to 1999/5/EC Radio Equipment & Telecommunications
Terminal Equipment Directive (FAX)

This Samsung product has been self-certified by Samsung for pan-European
single terminal connection to the analogue public switched telephone
network (PSTN) in accordance with Directive 1999/5/EC. The product has
been designed to work with the national PSTNs and compatible PBXs of the
European countries:

In the event of problems, you should contact the Euro QA Lab of Samsung
Electronics Co., Ltd. in the first instance.

The product has been tested against TBR21 and/or TBR 38. To assist in the
use and application of terminal equipment which complies with this standard,
the European Telecommunication Standards Institute (ETSI) has issued an
advisory document (EG 201 121) which contains notes and additional
requirements to ensure network compatibility of TBR21 terminals. The
product has been designed against, and is fully compliant with, all of the
relevant advisory notes contained in this document.

European Radio Approval Information (for products fitted with
EU-approved radio devices)

This Product is a printer; low power, Radio LAN type devices (radio frequency
(RF) wireless communication devices), operating in the 2.4 GHz/5 GHz band,
may be present (embedded) in your printer system which is intended for
home or office use. This section is only applicable if these devices are
present. Refer to the system label to verify the presence of wireless devices.

Wireless devices that may be in your system are only qualified for use in the
European Union or associated areas if a CE mark with C€ a Notified Body
Registration Number and the Alert Symbol is on the system label.

The power output of the wireless device or devices that may be embedded in
you printer is well below the RF exposure limits as set by the European
Commission through the R&TTE directive.

European States qualified under wireless approvals:




EU Austria, Belgium, Cyprus, Czech Republic, Denmark, Estonia, Finland,
France (with frequency restrictions), Germany, Greece, Hungary, Ireland,
Italy, Latvia, Lithuania, Luxembourg, Malta, The Netherlands, Poland,
Portugal, Slovakia, Slovenia, Spain, Sweden and the U.K.

EEA/EFTA countrieslceland, Liechtenstein, Norway and Switzerland

European States with restrictions on use:

EUIn France, the frequency range is restricted to 2446.5-2483.5 MHz for
devices above 10 mW transmitting power such as wireless

EEA/EFTA countriesNo limitations at this time.

Regulatory Compliance Statements

Wireless Guidance

Low power, Radio LAN type devices (radio frequency (RF) wireless
communication devices), operating in the 2.4 GHz/5 GHz Band, may be
present (embedded) in your printer system. The following section is a general
overview of considerations while operating a wireless device.

Additional limitations, cautions, and concerns for specific countries are listed
in the specific country sections (or country group sections). The wireless
devices in your system are only qualified for use in the countries identified by
the Radio Approval Marks on the system rating label. If the country you will
be using the wireless device in, is not listed, please contact your local Radio
Approval agency for requirements. Wireless devices are closely regulated
and use may not be allowed.

The power output of the wireless device or devices that may be embedded in
your printer is well below the RF exposure limits as known at this time.
Because the wireless devices (which may be embedded into your printer)
emit less energy than is allowed in radio frequency safety standards and
recommendations, manufacturer believes these devices are safe for use.
Regardless of the power levels, care should be taken to minimize human
contact during normal operation.

As a general guideline, a separation of 20 cm (8 inches) between the wireless
device and the body, for use of a wireless device near the body (this does not
include extremities) is typical. This device should be used more than 20 cm
(8 inches) from the body when wireless devices are on and transmitting.

This transmitter must not be collocated or operation in conjunction with any
other antenna or transmitter.

Some circumstances require restrictions on wireless devices. Examples of
common restrictions are listed below:

Radio frequency wireless communication can interfere with
equipment on commercial aircraft. Current aviation
regulations require wireless devices to be turned off while
traveling in an airplane. IEEE 802.11 (also known as wireless
Ethernet) and Bluetooth communication devices are
examples of devices that provide wireless communication.

In environments where the risk of interference to other
devices or services is harmful or perceived as harmful, the
option to use a wireless device may be restricted or
eliminated. Airports, Hospitals, and Oxygen or flammable
gas laden atmospheres are limited examples where use of
wireless devices may be restricted or eliminated. When in
environments where you are uncertain of the sanction to use
wireless devices, ask the applicable authority for
authorization prior to use or turning on the wireless device.

Every country has different restrictions on the use of wireless
devices. Since your system is equipped with a wireless
device, when traveling between countries with your system,
check with the local Radio Approval authorities prior to any
move or trip for any restrictions on the use of a wireless
device in the destination country.

If your system came equipped with an internal embedded
wireless device, do not operate the wireless device unless all
covers and shields are in place and the system is fully
assembled.

Wireless devices are not user serviceable. Do not modify
them in any way. Modification to a wireless device will void
the authorization to use it. Please contact manufacturer for
service.

Only use drivers approved for the country in which the device
will be used. See the manufacturer System Restoration Kit,
or contact manufacturer Technical Support for additional
information.

Replacing the Fitted Plug (for UK Only)

Important

The mains lead for this machine is fitted with a standard (BS 1363) 13 amp
plug and has a 13 amp fuse. When you change or examine the fuse, you
must re-fit the correct 13 amp fuse. You then need to replace the fuse cover.
If you have lost the fuse cover, do not use the plug until you have another fuse
cover.

Please contact the people from you purchased the machine.

The 13 amp plug is the most widely used type in the UK and should be
suitable. However, some buildings (mainly old ones) do not have normal 13
amp plug sockets. You need to buy a suitable plug adaptor. Do not remove
the moulded plug.

Warning
If you cut off the moulded plug, get rid of it straight away.

You cannot rewire the plug and you may receive an electric shock if you
plug it into a socket.

Important warning: You must earth this machine.
The wires in the mains lead have the following color code:

¢ Green and Yellow: Earth
* Blue: Neutral

* Brown: Live




If the wires in the mains lead do not match the colors marked in your plug, do
the following:

You must connect the green and yellow wire to the pin marked by the letter
“E” or by the safety ‘Earth symbol’ or colored green and yellow or green.

You must connect the blue wire to the pin which is marked with the letter “N”
or colored black.

You must connect the brown wire to the pin which is marked with the letter “L”
or colored red.

You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

OPENSSL LICENSE

Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software
must display the following acknowledgment: "This product includes
software developed by the OpenSSL Project for use in the OpenSSL
Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be
used to endorse or promote products derived from this software
without

5. prior written permission. For written permission, please contact
openssl-core@openssl.org.

6. Products derived from this software may not be called "OpenSSL"
nor may "OpenSSL" appear in their names without prior written
permission of the OpenSSL Project.

7. Redistributions of any form whatsoever must retain the following
acknowledgment: "This product includes software developed by the
OpenSSL Project for use in the OpenSSL Toolkit (http://
www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS"
AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

This product includes cryptographic software written by Eric
Young(eay@cryptsoft.com). This product includes software written by
Tim Hudson (tih@cryptsoft.com).

ORIGINAL SSLEAY LICENSE

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights
reserved.

This package is an SSL implementation written by Eric Young
(eay@cryptsoft.com). The implementation was written so as to conform
with Netscapes SSL.

This library is free for commercial and non-commercial use as long as
the following conditions are aheared to. The following conditions apply to
all code found in this distribution, be it the RC4, RSA, Ihash, DES, etc.,
code; not just the SSL code. The SSL documentation included with this
distribution is covered by the same copyright terms except that the
holder is Tim Hudson (tjh@cryptsoft.com). Copyright remains Eric
Young's, and as such any Copyright notices in the code are not to be
removed. If this package is used in a product, Eric Young should be
given attribution as the author of the parts of the library used. This can
be in the form of a textual message at program startup or in
documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

1. Redistributions of source code must retain the copyright notice, this
list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software
must display the following acknowledgement: "This product includes
cryptographic software written by Eric Young (eay@cryptsoft.com)"
The word 'cryptographic' can be left out if the rouines from the library
being used are not cryptographic related:-).

4. If you include any Windows specific code (or a derivative thereof)
from the apps directory (application code) you must include an
acknowledgement: "This product includes software written by Tim
Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

The licence and distribution terms for any publically available version or
derivative of this code cannot be changed. i.e. this code cannot simply
be copied and put under another distribution licence [including the GNU
Public Licence.]

Vi




1 Introduction

Thank you for purchasing this Samsung multifunctional product. Your
machine provides printing functions.

This chapter includes:

» Special features

* Machine overview

» Control panel overview

Caution

*This product is high glossy. Please be careful of surface scratch
during installation.

Special features

Your new machine is equipped with special features.

Print with excellent quality and speed
* You can print with a resolution of up to 1200 dpi
class Effective output.

+ Your machine prints A4-sized paper at up to 16 ppm?@
letter-sized paper at up to 17 ppm.

Handle different paper options with flexibility

The 100-sheet tray support plain paper in various
sizes.

a/

Create professional documents

+ Print Watermarks. You can customize your
documents with words, such as “Confidential”. See
Software section.

)

* Print Posters. The text and pictures of each page of
your document are magnified and printed across the
sheet of paper and can then be taped together to
form a poster. See Software section.

~
&

a. pages per minute

Save time and money

2

« To save paper, you can print multiple pages on one
single sheet of paper.

» This machine automatically conserves electricity by
substantially reducing power consumption when not in
use.

Print in various environments

:-
[

™

* You can print with various operating system such as
Windows, Linux and Macintosh systems.

* Your machine is equipped with a USB interface.

v + You can also use a network interface. Your machine
comes with a built-in network interface, 10/100 Base
TX and 802.11 b/g Wireless LAN.

1.1
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Machine overview

These are the main components of your machine.

Front view

AR

Y

M
AR
A
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A
AN\

e no
NS

1 control panel 6  tray open button
2 top cover 7  top cover lever
3 outputtray 8  toner cartridge
4 output support 9 inner cover
5 tray

Note

« All illustrations on this user’s guide may differ from your machine.
* The surface of the output tray may become hot if you print a large number of pages at once. Please make sure that you do not touch the surface,

and do not allow children near it.
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Rear view

USB port

4
5

rear cover

Network port

power switch

2
3

power receptacle
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Control panel overview
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display

Shows the current status and prompts during an operation. The message shows with specific LEDs as below. LEDs are working with short
message on a display.

* error LEDA
Blinks when the error occurs on your machine. If it blinks rapidly, the machine has stopped for some reason. Check the display message to
solve the problem.

» paper LED é
Blinks when the paper in the tray is empty.

- toner LED| 3,
Blinks when the estimated cartridge life of toner is close, or toner cartridge is invalid. Check the display message and replace the
toner cartridge.

+ paper jam LED 8
Lights blink when there is a paper jam in the machine. Check the display message to release the jammed paper.

See page 7.7 about more information on the display messages.

Stops an operation at any time. Also, You can print a machine report by pressing this button for about 4 seconds.

You can power on or off the control panel by pressing and holding this button for a few seconds.

Shows the status of wireless network. When the LED on, the machine is ready.

1.4 <introduction>




2 Software overview Supplied software

After you have set up your machine and connected it to your computer,
you must install the printer software. If you are a Windows or Macintosh
OS, install the software from the supplied CD and if you are a Linux OS
user, download the software from the Samsung website

This chapter includes: (www.samsung.com/printer) and install.:

This chapter gives you an overview of the software that comes with your
machine. Further details on how to use the software are explained in the
Software section.

* Supplied software
oS Contents

* Printer driver features

« System requirements Windows * Printer driver: Use this driver to take full
advantage of your machine’s features.

+ Smart Panel: This program allows you to monitor
the machine’s status and alerts you when an error
occurs during printing.

+ SetlP: Use this program to set your machine’s
TCP/IP addresses.

» User’s Guide in PDF

Linux * Linux printer driver: Use this driver to run your
machine from a Linux computer and print
documents.

+ SetlP: Use this program to set your machine’s
TCP/IP addresses.

Macintosh * Macintosh printer driver: Use this driver to run
your machine from a Macintosh computer and print
documents.

* Smart Panel: This program allows you to monitor
the machine’s status and alerts you when an error
occurs during printing.

* SetlIP: Use this program to set your machine’s
TCP/IP addresses.

2.1 <Software overview>




Printer driver features REQUIREMENT (RECOMMENDED)
OPERATING
Your printer drivers support the following standard features: SYSTEM FREE HDD
CPU RAM
. . . . SPACE
» Paper size, orientation and media type
* Number of copies Windows 7 Pentium IV 1 GHz 32- | 1 GB 16 GB
bit or 64-bit processor | (2 GB)
In addition, you can use various special printing features. The following or higher
table shows a general overview of features supported by your printer
drivers: »  Support for DirectX 9 graphics with 128 MB
memory(to enable the Aero theme).
Feature Windows | Linux | Macintosh * DVD-RW Drive
: . . Windows Pentium IV 1 512 MB 10 GB
Machine quality option o o o Server 2008 GHz(x86) or (2048 MB)
L R2 1.4GHz(x64)
Poster printing 0 X X processors(2GHz or
; faster)
Multiple pages per sheet (0] 0(2,4) 0]
(N-up) Note
Fit to page printing e} X 02 + Internet Explorer 5.0 or higher is the minimum requirement for
all Windows operating systems.
Scale printing o X + Users who have an administrator right can install the
software.
Watermark (0] X
Overlay (0] X

a. This feature is supported only MAC OS X 10.4 ~ 10.6.

System requirements

Before you begin, ensure that your system meets the following
requirements:

Windows

Your machine supports the following Windows operating systems.

REQUIREMENT (RECOMMENDED)

OPERATING
SYSTEM FREE HDD
CPU RAM SPACE
Windows Pentium 11 400 MHz 64 MB 600 MB
2000 (Pentium 111 933 MHz) | (128 MB)

Windows XP Pentium 111 933 MHz 128 MB 1.5GB
(Pentium IV 1 GHz) (256 MB)

Windows Pentium 111 933 MHz 128 MB 1.25 GB to
Server 2003 (Pentium IV 1 GHz) (512MB) | 2GB
Windows Pentium IV 1 GHz 512 MB 10 GB
Server 2008 (Pentium IV 2 GHz) (2048 MB)

Windows Pentium IV 3 GHz 512 MB 15 GB
Vista (1024 MB)

2.2  <Software overview>




Linux

Operating System

Requirements (recommended)

CPU RAM free HDD
space
RedHat 8.0, 9.0
(32bit)
RedHat Enterprise
Linux WS 4, 5
(32/64bit)
Fedora Core 1~7
(32/64bit)
Mandrake 9.2 (32bit),
10.0, 10.1 (32/64bit)
Mandriva 2005, 2006,
2007 (32/64bit . i
S | szve e
SuSE Linux 8.2, 9.0, I- telCore2 (1024 MB) | (2GB)
9.1 (32bit) (IntelCore2)
SuSE Linux 9.2, 9.3,
10.0, 10.1, 10.2
(32/64bit)
SuSE Linux Enterprise
Desktop 9, 10
(32/64bit)
Ubuntu 6.06, 6.10,
7.04 (32/64bit)
Debian 3.1, 4.0 (32/
64bit)
Macintosh
Requirements (recommended)
Operating
System CPU RAM free HDD
space

Mac OS X Intel » 128 MB for a Power-PC | 1 GB
10.3~10.4 Processor based Mac (512 MB).

Power PC | « 512 MB for an Intel-

G4 /G5 based Mac (1 GB)
Mac OS X Intel * 512 MB (1 GB) 1GB
10.5 Processor

867 MHz

or faster

Power PC

G4 /G5

Requirements (recommended)
Operating
System CPU RAM free HDD
space
Mac OS X * Intel 1 GB (2 GB) 1GB
10.6 processor
s
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. Place the machine on a flat and stable surface for not letting it lean
Get'“ N g Started more than 2 mm (0.08 inches). Otherwise, it may affect the printing
quality.
This chapter gives you step-by-step instructions for setting up the
machine.
- ,.--—---..--~l
This chapter includes: ypnas===="" %\
[ ] H
« Setting up the hardware '.' a n
« Setting up the network o |
B o I L PEL LN
* Using a wired network 2mm | { ooooosIsse=ssIiioo 1.1 ]2mm

* Using awireless network

» Altitude adjustment
J Unpack the machine and check all the enclosed items.

Remove the tape holding the machine tightly.

Setting up the hardware

Install both the toner cartridge.

This section shows the steps to set up the hardware which is explained
in the Quick Install Guide. Make sure you read Quick Install Guide and
complete following steps.

Load paper. (See "Loading paper in the tray" on page 4.5.)
Make sure that all the cables are connected to the machine.
1 Select a stable location. Turn the machine on.

Select a level, stable place with adequate space for air circulation.
Allow extra space to open covers and trays.

0o N o g b~ W DN

Install the software. See Software section.

The area should be well-ventilated and away from direct sunlight or
sources of heat, cold, and humidity. Do not set the machine close to This equipment will be inoperable when mains power fails.
the edge of your desk or table.

e Note

When the printer driver is in installation process, the driver
installer detects the locale information of your operating
system, and sets the default paper size for your machine. If
you use the different Windows locale, you must change the
paper size of your machine for matching your commonly
used paper size. Go to the printer properties to change the
paper size after installation completes.

100 mm 100 mm

(3.9in) (3.91n)

When you move the machine, do not tilt or turn it upside down.
Otherwise, the inside of the machine may be contaminated by
toner, which can cause damage to the machine or bad printing
quality.

N
)

|

482.6 mm (18.8in.)

Printing is suitable for altitudes under 1,000 m (3,281 ft). Refer to
the altitude setting to optimize your printing. See page 3.9 for more
information.

3.1 <Getting Started>




Setting up the network

You need to set up the network protocols on the machine (;printer) to use
it in the network environment. If you use your machine in the wired
network, refer to 'Using a wired network'. If you use your network printer
in the wireless network, refer to See "Using a wireless network" on
page 3.4.

Note

If you want to use the USB cable, connect the cable between a
computer and you machine. Then, refer to the software
installation in Software section.

Supported network environments

The following table shows the network environments supported by the
machine:

Item Requirements

10/100 Base-TX
802.11 b/g Wireless LAN

Network interface

Windows 2000/XP/2003/2008/Vista/7/Server
2008 R2

Various Linux OS
Macintosh Mac OS 10.3 ~ 10.6

Network operating
system

TCP/IP, Standard TCP/IP, LPR, IPP/ HTTP,
Bonjour, DHCP, BOOTP

Network protocols

Using a wired network

You must set up the network protocols on your printer to use it on your
network. This chapter will show you how this is easily accomplished.

Printing Configuration report

Press and hold Stop/Clear button for about 4 seconds to print a
machine report.

Please review your machines User’s Guide to learn of additional details.
Using this Network Configuration Report, you can find your machine
MAC address and IP address.

For example:
MAC Address :00:15:99:41:A2:78
IP Address :192.0.0.192

Setting IP address

Firstly, you have to set up an IP address for network printing and
managements. In most cases a new IP address will be automatically

assigned by a DHCP (Dynamic Host Configuration Protocol Server)
located on the network.

In a few situations the IP address must be set manually. This is called a
static IP and is often required in corporate Intranets for security reasons.

» DHCP IP assignment: Connect your machine to the network, and
wait a few minutes for the DHCP server to assign an IP address to the
machine. Then, print the Network Configuration Report as explained
above. If the report shows that the IP address has changed, the
assignment was successful. You will see the new IP address on the
report.

+ Static IP assignment: Use SetlP program to change the IP address
from your computer.

In an office environment, we recommend that you contact a network
administrator to set this address for you.

IP setting using the SetIP program
The following procedure is based on Windows XP.

This program is for manually setting the network IP address of your
machine using its MAC address to communicate with the machine. MAC
address is a hardware serial number of the network interface and can be
found in the Network Configuration Report.

Note

* You only need to run this program if your network requires a
static IP address. Otherwise, you may proceed to the
Configuring the machine’s wireless network part of this
document. If you are unsure of this requirement ask the system
administrator or the person who has set up your local network.

* You can only use the SetlP program when your machine is
connected to a network or directly connected to a PC with the
crossover network cable included with your machine. In most
cases we recommend using the crossover cable. You will be
asked to connect this cable in a moment.

Installing the program

1 Insert the driver CD provided along with your machine. When the
driver CD runs automatically, close the window.

2  Start Windows Explorer and open the X drive. (X represents your
CD-ROM drive.)

3 Double click Application > SetlP.
4  Double click Setup.exe to install this program.

5 Click OK.
If necessary, select a language from the drop-down list.

6 Follow the instruction on the window to complete the installation.

Starting the program

1 Connect your machine and the computer using crossover network
cable.

3.2
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2 Temporarily disable the computer firewall before continuing by doing
the following:

Window XP

* Open Control Panel.

» Double click Security
Center.

* Click Windows Firewall.

» Disable the firewall.

Macintosh OS

* Open System Preferences.
+ Click Sharing.

* Click the Firewall menu.

e Turn firewall off.

3 From the Windows Start menu, select All Programs > Samsung
Network Printer Utilities > SetIP > SetlP.

4 Clickonthe %} icon(third from left) in the SetIP window to open
the TCP/IP configuration window.

5 Enter the machine’s new information into the configuration window
as follows:
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* MAC Address: Find the machine’s MAC address from the Network
Configuration Report and enter it without the colons.
For example, 00:15:99:29:51:A8 becomes 0015992951A8.

Note

MAC address is a hardware serial number of the machine’s
network interface and can be found in on the Network
Configuration Report.

» IP Address: Enter a new IP address for your printer the same as the
computer’s IP address except for the last number.
For example, if your computer’s IP address is 192.168.1.150, enter
192.168.1.X. (X is number between 1 and 254 other than the
computer’s address.)

* Subnet Mask: Enter this exactly the same as the computer’s Subnet
Mask.

« Default Gateway: Enter this exactly the same as the computer’s
Default Gateway.

6 Click Apply, and then click OK. The machine will automatically print
the Configuration report. Confirm that all the settings are correct.

7  Click Exit to close the SetIP program.

8 If necessary, restart the computer’s firewall.

Network parameter setting

You can also set up the various network settings through the network
administration programs.

* SyncThru™ Web Admin Service: Web-based printer management
solution for network administrators. SyncThru™ Web Admin Service
provides you with an efficient way of managing network devices and
lets you remotely monitor and troubleshoot network machines from
any site with corporate internet access. Download this program from
http://solution.samsungprinter.com.

* SyncThru™ Web Service: Web server embedded on your network
print server, which allows you to: (A) Configure the network
parameters necessary for the machine to connect to various network
environments. (B) Customize machine settings.

Installing the software

You must install the printer driver software for printing. The software
includes drivers, applications, and other user friendly programs.

Note

The following procedure is based on Windows XP. The procedure
and popup window which appears during the installation may
differ depending on the operating system, machine features, or
the interface in use.

Make sure that the network setup for your machine is completed. (See
"Setting up the network" on page 3.2.) All applications should be closed
on your computer before beginning the installation.

If your IP assignment method is DHCP and IP address can be changed
whenever machine in turned on, we recommend you to use the Bonjour
program. Go to the http://developer.apple.com/networking/bonjour/
download/, select the program Bonjour for Windows according to your
computer operating system, and install the program. In case of Mac OS
X, this program might be already installed in your PC. This program will
allow you to fix the network parameter automatically. This Bonjour
program does not support Linux.

If your IP assignment method is static, follow the steps below.

1 Insert the Printer Software CD-ROM into your CD-ROM drive. The
CD-ROM should automatically run, and an installation window
appears.

2 Click Next.

If the installation window does not appear, click Start > Run. Type
X:\Setup.exe, replacing “X” with the letter which represents your
drive and click OK.

If you use Windows Vista, Windows 7 and Windows Server 2008
R2, click Start > All Programs > Accessories > Run, and type
X:\Setup.exe.

Note

The installation window may slightly differ, if you are
reinstalling the driver.

3 Select Typical installation for a network printer, and then click
Next.
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4  The list of machines available on the network appears. Select the
printer you want to install from the list and then click Next.

Note

«If you do not see your machine on the list, click Update to
refresh the list, or select Add TCP/IP Port to add your
machine to the network. To add the machine to the
network, enter the port name and the IP address for the
machine.

*To verify your machine’s IP address or the MAC address,
print a Network Configuration Report page.

5After the installation is finished, a window appears asking
you to print a test page and to register yourself as a user of
Samsung machines in order to receive information from Samsung. If
you so desire, select the corresponding checkbox(es) and click
Finish.

Note

If your machine does not work properly after the installation,
try to reinstall the printer driver. See Software section.

Using a wireless network

You must set up the network protocols on your machine to use it on your
network. This chapter will show you how this is easily accomplished.

Before starting, please locate the crossover network cable and the Printer
Software Installation CD-ROM provided with your machine (;printer). You
may need to contact a network administrator or the person who has set
up your wireless network for information regarding the configuration.

If you are already aware of your machine’s IP address configuration and
this IP address is available, you may go to Configuring the machine’s
wireless network part directly. Otherwise you have to follow all steps
from Checking your Network Environments part.

Checking your Network Environments

IP address

Every device in a network is identified by a unique numerical address
called an IP Address. Your machine came with a default IP address of
192.0.0.192, and you can verify this by printing out a Network
Configuration Report. In most cases a new IP address will be
automatically assigned by a DHCP (Dynamic Host Configuration Protocol
Server) located on the network.

In a few situations the IP address must be set manually. This is called a
static IP and is often required in corporate Intranets for security reasons.
We have provided an easy to use utility program on the Printer Software
CD-ROM named SetlP that can change the address for you.

In an office environment, we recommend that you contact a network
administrator to set this address for you.

Wireless Networks

« Infrastructure mode: An Infrastructure mode network is the most
common wireless network configuration in a home or office consisting
of a wireless router, or an access point, that connects all the
computers and other networked devices into a common local area
network (LAN).

The access point provides a special high speed connection to a Cable
or DSL modem or other wide area network (WAN) device that
connects the LAN to the Internet or a Corporate Intranet. Most
Infrastructure mode networks use a DHCP Server to automatically
assign the IP address and set other network parameters. If you know
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that you are connecting to an Infrastructure mode network with an
access point, and the IP address is assigned by a DHCP server, you
may proceed to the Configuring the machine’s wireless network
part after reviewing the following parts on printing a Network
Configuration Report.

If you know that you are connecting to an Infrastructure mode network
with an access point, but it does not have DHCP address assignment,
or you are required to set a static IP, proceed to the Setting IP
address part before going to Configuring the machine’s wireless
network part after reviewing the following parts on printing a Network
Configuration Report.

* Ad-hoc mode : An Ad-hoc mode network provides peer to peer
communication. In an Ad-hoc mode network, wireless devices and
computers communicate directly with each other, without using an
access point. They can share files and machines, but may not be able
to access the Internet. The machine receives print jobs fromwireless
computers directly.

If you know that you are connecting to an ad-hoc mode network without
an access point, proceed to the Setting IP address part before going to
Configuring the machine’s wireless network part after reviewing the
following parts on printing a Network Configuration Report.
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Printing Configuration report

Press and hold Stop/Clear button for about 4 seconds to print a
machine report.

Please review your machines User’s Guide to learn of additional details.
Using this Network Configuration Report, you can find your machine
MAC address and IP address.

For example:
MAC Address :00:15:99:41:A2:78
IP Address :192.0.0.192

Setting IP address

Firstly, you have to set up an IP address for network printing and
managements. In most cases a new IP address will be automatically
assigned by a DHCP (Dynamic Host Configuration Protocol Server)
located on the network.

In a few situations the IP address must be set manually. This is called a

static IP and is often required in corporate Intranets for security reasons.

* DHCP IP assignment: Connect your machine to the network, and
wait a few minutes for the DHCP server to assign an IP address to the
machine. Then, print the Network Configuration Report as explained
above. If the report shows that the IP address has changed, the
assignment was successful. You will see the new IP address on the
report.

« Static IP assignment: Use SetlP program to change the IP address
from your computer.

In an office environment, we recommend that you contact a network
administrator to set this address for you.

IP setting using the SetIP program
The following procedure is based on Windows XP.

This program is for manually setting the network IP address of your
machine using its MAC address to communicate with the machine. MAC
address is a hardware serial number of the network interface and can be
found in the Network Configuration Report.

Note

* You only need to run this program if your network requires a
static IP address. Otherwise, you may proceed to the
Configuring the machine’s wireless network part of this
document. If you are unsure of this requirement ask the system
administrator or the person who has set up your local network.

* You can only use the SetlP program when your machine is
connected to a network or directly connected to a PC with the
crossover network cable included with your machine. In most
cases we recommend using the crossover cable. You will be
asked to connect this cable in a moment.

Installing the program

1 Insert the driver CD provided along with your machine. When the
driver CD runs automatically, close the window.

2 Start Windows Explorer and open the X drive. (X represents your
CD-ROM drive.)

3 Double click Application > SetlP.
4  Double click Setup.exe to install this program.

5 Click OK.
If necessary, select a language from the drop-down list.

6 Follow the instruction on the window to complete the installation.

Starting the program

1 Connect your machine and the computer using crossover network
cable.

2 Temporarily disable the computer firewall before continuing by doing
the following:

Macintosh OS

* Open Control Panel. » Open System Preferences.
» Double click Security * Click Sharing.
Center. + Click the Firewall menu.
* Click Windows Firewall. * Turn firewall off.
 Disable the firewall.

Window XP

3 From the Windows Start menu, select All Programs > Samsung
Network Printer Utilities > SetIP > SetIP.

4 Clickonthe %} icon(third from left) in the SetIP window to open
the TCP/IP configuration window.

5 Enter the machine’s new information into the configuration window
as follows:
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* MAC Address: Find the machine’s MAC address from the Network
Configuration Report and enter it without the colons.
For example, 00:15:99:29:51:A8 becomes 0015992951A8.

Note

MAC address is a hardware serial number of the machine’s
network interface and can be found in on the Network
Configuration Report.
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IP Address: Enter a new IP address for your printer the same as the
computer’s |IP address except for the last number.

For example, if your computer’s IP address is 192.168.1.150, enter
192.168.1.X. (X is number between 1 and 254 other than the
computer’s address.)

Subnet Mask: Enter this exactly the same as the computer’s Subnet
Mask.

Default Gateway: Enter this exactly the same as the computer’s
Default Gateway.

Click Apply, and then click OK. The machine will automatically print
the Configuration report. Confirm that all the settings are correct.

Click Exit to close the SetlP program.

If necessary, restart the computer’s firewall.

Network parameter setting

You can also set up the various network settings through the network
administration programs.

SyncThru™ Web Admin Service: Web-based printer management
solution for network administrators. SyncThru™ Web Admin Service
provides you with an efficient way of managing network devices and
lets you remotely monitor and troubleshoot network machines from
any site with corporate internet access. Download this program from
http://solution.samsungprinter.com.

SyncThru™ Web Service: Web server embedded on your network
print server, which allows you to: (A) Configure the network
parameters necessary for the machine to connect to various network
environments. (B) Customize machine settings.

Restoring factory default settings

You can restore factory default settings to the machine by using
SyncThru™ Web Service. You may need to reset the machine to the
factory default settings when machine that you are using is connected to
new network environment.

Restoring factory default settings using SyncThru™ Web
Service

1

Start a web browser such as Internet Explorer, Safari or Firefox and
enter your machine’s new IP address in the browser window.
For example,

& hitp://192, 188,113/

When the SyncThru™ Web Service window opens, click Network
Settings.

Click Reset. Then, click Clear for network.
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Turn off and restart machine to apply settings.
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Configuring the machine’s wireless network

Before starting you will need to know the SSID of your wireless network
and the Network Key if it is encrypted. This information was set when the
access point was installed. If you do not know about your wireless
environment, please ask the person who has set up your network.

Using SyncThru™ Web Service

Before starting wireless parameter configuration, make sure cable
connection status.

1 Start a web browser such as Internet Explorer, Safari or Firefox and
enter your machine’s new IP address in the browser window.
For example,

(& http://192,166,1.133/

2 When the SyncThru™ Web Service window opens, click Network
Settings.

3 Click Wireless and Select Wizard. Then, click Next.

Note

Wizard will help you setup the wireless network
configuration. However, if you want to set the wireless
network directly, select Custom.
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» SSID: SSID(Service Set Identifier) is a name that identifies a wireless
network. Access points and wireless devices attempting to connect to
a specific wireless network must use the same SSID. The SSID is
case-sensitive.

» Operation Mode: Operation Mode refers to the type of wireless
connections.
- Ad-hoc: allows wireless devices to communicate directly with each
other in a peer-to-peer environment.
- Infrastructure: allows wireless devices to communicate with each
other through an access point.

Note

If your network’s operation mode is Infrastructure, select the
SSID of the access point. If the operation mode is Ad-hoc,
select the machine’s SSID. Note that “airportthru” is the
default SSID of your machine.
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5 Click Next.
If wireless security setting window appears, enter the registered
password (network key) and click Next.
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6 Wizard Setup Confirmation window appears, please check your
wireless setup. If the setup is right, click Apply.

7 Click OK.
Note

» Disconnect the network cable (standard or crossover). Your
machine should then start communicating wirelessly with the
network. In case of Ad-hoc mode, you can use a wireless LAN
and wired LAN simultaneously.

« If Operation Mode is Infrastructure, you must disconnect the
network cable to activate wireless network after completing the
network setting.

Now go to Installing the software.

Installing the software

You must install the printer driver software for printing. The software
includes drivers, applications, and other user friendly programs.

Note

The following procedure is based on Windows XP. The procedure
and popup window which appears during the installation may
differ depending on the operating system, machine features, or
the interface in use.

Make sure that the network setup for your machine is completed. (See
"Setting up the network" on page 3.2.) All applications should be closed
on your computer before beginning the installation.

If your IP assignment method is DHCP and IP address can be changed
whenever machine in turned on, we recommend you to use the Bonjour
program. Go to the http://developer.apple.com/networking/bonjour/

download/, select the program Bonjour for Windows according to your

computer operating system, and install the program. In case of Mac OS
X, this program might be already installed in your PC. This program will
allow you to fix the network parameter automatically. This Bonjour
program does not support Linux.

If your IP assignment method is static, follow the steps below.

1 Insert the Printer Software CD-ROM into your CD-ROM drive. The
CD-ROM should automatically run, and an installation window
appears.

2 Click Next.

If the installation window does not appear, click Start > Run. Type
X:\Setup.exe, replacing “X” with the letter which represents your
drive and click OK.

If you use Windows Vista, Windows 7 and Windows Server 2008
R2, click Start > All Programs > Accessories > Run, and type
X:\Setup.exe.

Note

The installation window may slightly differ, if you are
reinstalling the driver.

3 Select Typical installation for a network printer, and then click
Next.

4  The list of machines available on the network appears. Select the
printer you want to install from the list and then click Next.

Note

«If you do not see your machine on the list, click Update to
refresh the list, or select Add TCP/IP Port to add your
machine to the network. To add the machine to the
network, enter the port name and the IP address for the
machine.

*To verify your machine’s IP address or the MAC address,
print a Network Configuration Report page. (See "Printing a
machine report" on page 8.1.)

5 After the installation is finished, a window appears asking you to
print a test page and to register yourself as a user of Samsung
machines in order to receive information from Samsung. If you so
desire, select the corresponding checkbox(es) and click Finish.

Note
If your machine does not work properly after the installation,
try to reinstall the printer driver. See Software section.
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Altitude adjustment

The print quality is affected by atmospheric pressure, which is determined
by the height of the machine above sea level. The following information
will guide you on how to set your machine to the best print quality or best
quality of print.

The altitude above 1,000 m (3,281 ft), may affect the print quality such as
loose toner or light imaging.

Before you set the altitude setting, find the altitude where you are using
the machine.

To set the machine for high altitude, follow next step:
Note

The following procedure is for Windows XP. For other Windows
OS, refer to the corresponding Windows User's Guide or online
help.

1 Click the Windows Start menu.

Select Printers and Faxes.

Select Samsung ML-1630W Series icon.

Right-click on the printer driver icon and select Properties.

Click the Printer tab and select the High Altitude Correction.

o o0 b~ WDN

Click OK.
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4 Selecting and loading print

This chapter introduces you how to load originals and print media into

media

your machine.

This chapter includes:

Selecting print media
Loading paper in the tray
Setting the paper size and type

Selecting print media

You can print on a variety of print media, such as plain paper, labels, and
transparencies. Always use print media that meet the guidelines for use
with your machine. Print media that does not meet the guidelines outlined
in this user’s guide may cause the following problems:

Poor print quality
Increased paper jams
Premature wear on the machine.

Properties, such as weight, composition, grain, and moisture content, are
important factors that affect the machine’s performance and the output
quality. When you choose print materials, consider the following:

The type, size and weight of the print media for your machine are
described later in this section.

Desired outcome: The print media you choose should be appropriate
for your project.

Brightness: Some print media are whiter than others and produce
sharper, more vibrant images.

Surface smoothness: The smoothness of the print media affects how
crisp the printing looks on the paper.

Note

» Some print media may meet all of the guidelines in this section
and still not produce satisfactory results. This may be the result
of improper handling, unacceptable temperature and humidity
levels, or other variables over which Samsung has no control.

» Before purchasing large quantities of print media, ensure that it
meets the requirements specified in this user’s guide.

Using print media that does not meet these specifications may
cause problems, requiring repairs. Such repairs are not covered
by Samsung’s warranty or service agreements.
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Guidelines for selecting and storing print media

When selecting or loading paper, or other print materials, keep these
guidelines in mind:

Always use print media that conform with the specifications listed on
page 4.3.

Attempting to print on damp, curled, wrinkled, or torn paper can cause

paper jams and poor print quality.

For the best print quality, use only high quality copier grade paper

specifically recommended for use in laser machines.

Avoid using the following media types:

- Paper with embossed lettering, perforations, or a texture that is too
smooth or too rough

- Erasable bond paper

- Multi-paged paper

- Synthetic paper and thermally reactive paper

- Carbonless paper and Tracing paper.

Use of these types of paper could result in paper jams, chemical

smells, and damage to your machine.

Store print media in its ream wrapper until you are ready to use it.

Place cartons on pallets or shelves, not on the floor. Do not place

heavy objects on top of the paper, whether it is packaged or

unpackaged. Keep it away from moisture or other conditions that can

cause it to wrinkle or curl.

Store unused print media at temperatures between 15 °C and 30 °C.

The relative humidity should be between 10% and 70%.

Store unused print media in a moisture-proof wrap, such as a plastic

container or bag, to prevent dust and moisture from contaminating

your paper.

Load special media types one sheet at a time through the tray to avoid

paper jams.

To prevent print media, such as transparencies and label sheets, from

sticking together, remove them as they print out.
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Specifications on print media

Note

. (% Due to the nature of the product, the envelope type of media cannot be used with your machine.

*Use the print media type mentioned below only.

Type Size Dimensions Weight? Capacityb
Letter 216 x 279 mm (8.5 x 11 inches)
A4 210 x 297 mm (8.26 x 11.69 inches)
JIS B5 182 x 257 mm (7.16 x 10.11 inches) 100 sh ; 2
2 sheets of 75 g/m
Plain paper ISO B5 176 x 250 mm (6.93 x 9.84 inches) ggntg;fi? t%g“tré;s 03216 |20 Ib bond) paper for the
tray
A5 148 x 210 mm (5.82 x 8.26 inches)
A6 105 x 148 mm (4.13 x 5.82 inches)
Executive 184 x 267 mm (7.25 x 10.5 inches)
2
Transparency® Letter, A4 Refer to the Plain paper section :)ggdt;) 146 g/m* (3710 39 Ib 1 sheet for the tray
2
Labels Letter, A4 Refer to the Plain paper section ;ggdt;) 150 g/m* (32 t0 40 Ib 1 sheet for the tray
2
Card stock Letter, A4 Refer to the Plain paper section gg;g; 20 g/m? (16 to 32 Ib 1 sheet for the tray
Minimum size (custom) 105 x 148 mm (4.13 x 5.83 inches)
60 to 120 g/m? (16 to 32 Ib bond) for the tray
Maximum size (custom) 216 x 297 mm (8.5 x 11.69 inches)

a. If media weight is over 105 g/m? (28Ib bond), load a paper into the tray one by one.

b. Maximum capacity may differ depending on media weight, thickness, and environmental conditions.

c. Recommended media: Transparency for a Laser Printers produced by HP, Xerox and 3M.

It is not recommended to use paperbacked transparencies such as Xerox 3R91334, which can cause a jam or be scratched.

Note
*When you use the thick paper (90 to 120 g/m?, 24 to 32 Ib bond), select Thick Paper in the paper type. See 4.6 page.
» When you use the thin paper (under 70 g/m2, under 19 Ib bond), select Thin Paper in the paper type. See 4.6 page.
» When you use the recycled paper, select Recycled Paper in the paper type. See 4.6 page.
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Guidelines for special print media

Media type

Guidelines

Transparencies

To avoid damaging the machine, use only
transparencies designed for use in laser
machines.

Transparencies used in the machine must be
able to withstand the machine’s fusing
temperature. Check your machine’s specification
to view the fusing temperature, see page 9.1.
Place them on a flat surface after removing them
from the machine.

Do not leave them in the paper tray for long
periods of time. Dust and dirt may accumulate
on them, resulting in spotty printing.

To avoid smudging caused by fingerprints,
handle them carefully.

To avoid fading, do not expose printed
transparencies to prolonged sunlight.

Ensure that transparencies are not wrinkled,
curled, or have any torn edges.

Recommended media: Transparency for a
Color Laser Printers produced by HP,
Xerox and 3M. It is not recommended to
use paperbacked transparencies such as
Xerox 3R91334, which can cause a jam or
be scratched.

Note

If your machine does not feed the
transparency print media properly, put a
blank sheet of paper under the
transparency, and try again.

Media type

Guidelines

Labels

To avoid damaging the machine, use only labels

designed for use in laser machines.

When selecting labels, consider the following

factors:

- Adhesives: The adhesive material should be
stable at your machine’s fusing temperature.
Check your machine’s specification to view the
fusing temperature, see page 9.1.

- Arrangement: Only use labels with no
exposed backing between them. Labels can
peel off sheets that have spaces between the
labels, causing serious jams.

- Curl: Prior to printing, labels must lie flat with
no more than 13 mm of curl in any direction.

- Condition: Do not use labels with wrinkles,
bubbles, or other indications of separation.

Make sure that there is no exposed adhesive

material between labels. Exposed areas can

cause labels to peel off during printing, which
can cause paper jams. Exposed adhesive can
also cause damage to machine components.

Do not run a sheet of labels through the machine

more than once. The adhesive backing is

designed for only a single pass through the
machine.

Do not use labels that are separating from the

backing sheet or are wrinkled, bubbled, or

otherwise damaged.

Card stock or
custom-sized
materials

Do not print on media smaller than 105 mm wide
or 148 mm long.

In the software application, set margins at least
6.4 mm away from the edges of the material.

Note
If you experience jams with card stock
feeding, turn the paper around and try
again.

Preprinted
paper

Letterhead must be printed with heat-resistant
ink that will not melt, vaporize, or release
hazardous emissions when subjected to the
printer’s fusing temperature for 0.1 second.
Check your machine’s specification to view the
fusing temperature, see page 9.1.

Letterhead ink must be non-flammable and
should not adversely affect printer rollers.
Forms and letterhead should be sealed in a
moisture-proof wrapping to prevent changes
during storage.

Before you load preprinted paper, such as forms
and letterhead, verify that the ink on the paper is
dry. During the fusing process, wet ink can come
off preprinted paper, reducing print quality.
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Loading paper in the tray Changing the paper size in the tray

To load different sizes of paper, such as custom-sized paper, you need to
Load the print media you use for the majority of your print jobs in the tray. adjust the paper guides.

The tray can hold a maximum of 100 sheets of 75 g/m? (20 Ib bond) plain
paper.

1 Press the tray open button, then the tray pops out. Pull the tray P2}
completely out.

paper length guide

paper width guide

AR

1 Adjust the paper length guide to the desired paper length. It is
preset to Letter or A4 size depending on the country. To load
another size, hold the lever and move the length guide to the
corresponding position.

Note
When the tray does not close properly, pull the tray half way out
and try again.

2 Place paper with the side you want to print facing down.

//%
@
v Note
* The tray is preset to Letter or A4 size, depending on your

country.

» For example, if you want to change the size to Letter, hold the
lever at the back of the tray, and rotate the lever clockwise.

3 Align the tray with the slot, and slide it into the machine.

4  After loading paper, set the paper type and size for the tray. See
Software section for PC-printing.

Note

* You can load previously printed paper. The printed side should
be facing up with an uncurled edge at the rear. If you
experience problems with paper feed, turn the paper around.
Note that print quality is not guaranteed.
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After inserting paper into the tray, while pinching the paper width
guide as shown, move it toward the stack of paper until it lightly
touches the side of the stack. Do not press the guide too tightly to
the edge of the paper; the guide may bend the paper.

Note

» Do not push the paper width guides far enough to cause the
materials to warp.

« If you do not adjust the paper width guides, it may cause paper

jams.
4 % =
= =

Setting the paper size and type

The settings you change remain in effect only while you are using the
current program. To make your changes permanent, make them in the
Printers folder.

Note
The following procedure is for Windows XP. For other Windows
OS, refer to the corresponding Windows User's Guide or online
help.

1 Click the Start button on the computer screen.
2 Select Printers and Faxes.

3 Right-click on the printer driver icon and select Printing
Preferences.

4  Click the Paper tab, and change the settings on Paper Options.
5 Click OK.
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5 Basic printing

This chapter explains common printing tasks. Your machine allows you to
print from various Windows, Macintosh, or Linux applications.

Note
The following procedure is for Windows operating system.
For Linux and Macintosh, see Software section.

Printing a document

The exact steps for printing a document may vary depending on the
application you use.

1 Open the document you want to print.

2 Select Print from the File menu. The Print window is displayed. It
may look slightly different depending on your application.

3 Select your printer driver from the Selet Printer list.

4 To start the print job, click OK or Print in the Print window.

For details about printing, see Software section.

Canceling a print job

If the print job is waiting in a print queue or print spooler, such as the
printer group in Windows, delete the job as follows:

1 Click the Windows Start menu.

2 For Windows 2000, select Settings and then Printers.
For Windows XP/2003, select Printers and Faxes.

For Windows Vista/2008, select Control Panel > Hardware and
Sound > Printers.

For Windows 7, select Control Panel > Hardware and Sound >
Devices and Printers.

For Windows Server 2008 R2, select Control Panel > Hardware >
Devices and Printers.

3 For Windows 2000, XP, 2003, 2008 and Vista, double-click your
machine.

For Windows 7 and Windows Server 2008 R2, right click your
printer icon > context menus > See what’ s printing.

4 From the Document menu, select Cancel.

Note
You can also access this window by simply double-clicking the
printer icon at the bottom right corner of the Windows desktop.

You can also cancel the current job by pressing @ on the control
panel.

5.1
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6 Maintenance

This chapter provides information for maintaining your machine and the
toner cartridge.

This chapter includes:

e Printing a machine report

e Cleaning your machine

e Maintaining the cartridge

* Redistributing toner

* Replacing the toner cartridge

* Maintenance Parts

e Managing your machine from the website

Printing a machine report

Press and hold Stop/Clear button for about 4 seconds to print a
machine report.

Cleaning your machine

To maintain print quality, follow the cleaning procedures below each time
the toner cartridge is replaced or if print quality problems occur.

+ Cleaning the machine cabinet with cleaning materials that
contain large amounts of alcohol, solvent, or other strong
substances can discolor or damage the cabinet.

* If your machine or its surrounding is contaminated with toner,
we recommend you to use cloth or tissue dampened with
water to clean it. If you use a vacuum cleaner, toner blows in
the air and might be harmful for you.

+ After cleaning, wipe the cabinet to remove any moisture.

Cleaning the outside

Make sure to brush off the dirt on the cloth provided before cleaning the
cabinet. Make sure to spray water 4 to 6 times onto the cloth provided, or
another cloth suitable for this purpose before cleaning the cabinet, wiping
in on direction.

Cleaning the inside

During the printing process, paper, toner and dust particles can
accumulate inside the machine. This buildup can cause print quality
problems, such as toner specks or smearing. Cleaning the inside of the
machine clears or reduces these problems. Contact a service
representative to clean the parts inside the machine.

1 Press the top cover lever, completely open the top cover.

2  Grasp the handles on the toner cartridge and pull to remove the
cartridge from the machine.

* Do not touch the green surface, the OPC drum or the front of
the toner cartridge, with your hands or any other material.
Use the handle on each cartridge in order to avoid touching
this area.

+ If you leave the top cover open for more than a few minutes,
the OPC drum can be exposed to light. This will cause
damage to the OPC drum. Close the top cover should the
installation need to be halted for any reason.

6.1
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3 With a dry lint-free cloth, wipe away any dust and spilled toner from 5 Slide the toner cartridge back into the machine.
the toner cartridges area and their cavities.

6 Hold the top cover and close it slowly and carefully, until the cover is
the cover is securely latched.

Note
If toner gets on your clothing, wipe it off with a dry cloth and
wash it in cold water. Hot water sets toner into fabric.

4 Locate the long strip of glass (LSU) inside the front door, and gently
swab the glass to see if dirt turns the white cotton black.

Note
If the top cover is not completely closed, the machine will not
operate.

Caution
Be careful not to pinch your fingers, since the top cover is very
heavy.
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Maintaining the cartridge

Toner cartridge storage

Toner cartridges contain components that are sensitive to light,
temperature, and humidity. Samsung suggests users follow the
recommendations to ensure the optimum performance, highest quality,
and longest life from your new Samsung toner cartridge.

Store this cartridge in the same environment as the printer it will be used
in; this should be in controlled office temperature and humidity conditions.
The toner cartridge should remain in its original, unopened package until
installation — If original packaging is not available, cover the top opening
of the cartridge with paper and store in a dark cabinet.

Opening the cartridge package prior to use dramatically shortens its
useful shelf and operating life. Do not store on the floor. If the toner
cartridge is removed from the printer, always store the cartridge:

* Inside the protective bag from the original package
 Correct side up in a horizontal position (not standing on end)

+ Do not store consumables in;
- Temperature greater than 40°C (104°F).
- Humidity range less than 20% and not greater than 80%.
- An environment with extreme changes in humidity or temperature.
- Direct sunlight or room light.
- Dusty places.
- A car for a long period of time.
- An environment where corrosive gases are present.

* An environment with salty air.

Handling instructions

» Do not touch the surface of the photosensitive drum in the cartridge.
» Do not expose the cartridge to unnecessary vibrations or shock.

» Never manually rotate the drum, especially in the reverse direction;
this can cause internal damage and toner spillage.

Use of non-Samsung and refilled toner cartridge

Samsung Electronics does not recommend or approve the use of non-
Samsung brand toner cartridges in your printer including generic, store
brand, refilled, or remanufactured toner cartridges.

+ Samsung’s printer warranty does not cover damage to the
machine caused by the use of a refilled, remanufactured, or
non-Samsung brand toner cartridge.

Estimated cartridge life

Estimated cartridge life (the life of the toner cartridge yield) depends on
the amount of toner that print jobs require. The actual print-out number
may vary depending on the print density of the pages you print on,
operating environment, printing interval, media type, and/or media size.
For example, if you print a lot of graphics, the consumption of the toner is
high and you may need to change the cartridge more often.

Redistributing toner

When small amount of toner is left in the cartridge, the toner
LED(l.z_.,) blinks slowly. It may cause faded or light areas on a paper. You
can temporarily improve print quality by redistributing the toner.

For detailed information about error message, see page 7.7.

Note
In some cases, white streaks or light printing will still occur even
after you have redistributed the toner.

1 Press the top cover lever, completely open the top cover.

—

2 Grasp the handles on the toner cartridge and pull to remove the
cartridge from the machine.
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3 Holding side edges of the toner cartridge, thoroughly rock it from 5 Hold the top cover and close it slowly and carefully, until the cover is
side to side to redistribute the toner. the cover is securely latched.

* Do not touch the green surface, the OPC drum or the front of
the toner cartridge, with your hands or any other material.
Use the handle on each cartridge in order to avoid touching
this area.

+ If you leave the top cover open for more than a few minutes,
the OPC drum can be exposed to light. This will cause
damage to the OPC drum. Close the top cover should the
installation need to be halted for any reason.

Note
Note If the top cover is not completely closed, the machine will not
If toner gets on your clothing, wipe it off with a dry operate.
cloth and wash it in cold water. Hot water sets toner into
fabric.
Be careful not to pinch your fingers, since the top cover is very
4  Slide the toner cartridge back into the machine. heavy.
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Replacing the toner cartridge

* The toner LED(; 3)) blinks rapidly and the toner-related messages on
the display indicate when toner cartridge should be replaced.
For detailed information about error message, see page 7.7.

» The machine stops printing.

At this stage, the toner cartridge needs to be replaced. Check the type of
toner cartridge for your machine. (See "Supplies" on page 8.1.)

1 Turn the machine off, then wait a few minutes for the machine to
cool.

2 Press the top cover lever, completely open the top cover.

3 Grasp the handles on the toner cartridge and pull to remove the
cartridge from the machine.

4  Take a new toner cartridge out of its package.

Caution

» Don't use sharp objects, such as a knife or scissors, to open
the toner cartridge package. You could damage the surface of
the toner cartridge.

+ To prevent damage, do not expose the toner cartridge to light
for more than a few minutes. Cover it with a piece of paper to
protect it if necessary.

5 Holding side edges of the toner cartridge, thoroughly rock it from
side to side to redistribute the toner.

6 Place the toner cartridge on a flat surface, as shown, and remove
the paper covering the toner cartridge.
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Note

* Do not touch the green surface, the OPC drum or the front of If the top cover is not completely closed, the machine will not
each toner cartridge, with your hands or any other material. operate.
Use the handle on each cartridge in order to avoid touching
this area.

« If you leave the top cover open for more than a few minutes, Be careful not to pinch your fingers, since the top cover is very
the OPC drum can be exposed to light. This will cause heavy.

damage to the OPC drum. Close the top cover should the
installation need to be halted for any reason.

Note
If toner gets on your clothing, wipe it off with a dry cloth and
wash it in cold water. Hot water sets toner into fabric.
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7 Insert the cartridge into place.
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Maintenance Parts

To avoid print quality and paper feed problems resulting from worn parts,
and to maintain your machine in top working condition the following
condition, the following items will need to be replaced after the specified
number of pages, or when the life span of each item has expired.

Items Yield (Average)
Transfer roller Approx. 50,000 pages
8 Hold the top cover and close it slowly and carefully, until the cover is Fuser unit Approx. 50,000 pages
the cover is securely latched. Paper feed roller Approx. 50,000 pages

We highly recommend that this maintenance be performed by an
authorized service provider, dealer or the retailer where you bought the
machine. The warranty does not cover the replacement of the
maintenance parts after their lifespan.
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Managing your machine from the website

If you have connected your machine to a network and set up TCP/IP
network parameters correctly, you can manage the machine via
Samsung’s SyncThru™ Web Service, an embedded web server. Use
SyncThru™ Web Service to:

» View the device information and check its current status.
» Change TCP/IP parameters and set up other network parameters.
» Change the printer properties.

» Set the machine to send email notifications and update you on the
machine’s status.

» Get support for using the machine.
To access SyncThru™ Web Service:
1 Start a web browser, such as Internet Explorer, from Windows.

2 Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address
field and press the Enter key or click Go.

Your machine’s embedded website opens.
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7 T bl h ti In the paper feed area and rear the machine
rou eshootin g If paper is jammed in the paper feed area and rear the machine, follow

This chapter gives helpful information on what to do if you encounter a the next steps to release the jammed paper.

problem. 1 Press the tray open button.

This chapter includes:

» Tips for avoiding paper jams

e Clearing paper jams

* Understanding display messages
* Solving other problems

Tips for avoiding paper jams

By selecting the correct media types, most paper jams can be avoided.

When a paper jam occurs, follow the steps outlined on page 7.1.

» Follow the procedures on page 4.5. Ensure that the adjustable guides 2

are positioned correctly.

» Do not overload the tray. Ensure that the paper level is below the
paper capacity mark on the inside of the tray.

» Do not remove paper from the tray while your machine is printing.
» Flex, fan, and straighten paper before loading.

» Do not use creased, damp, or highly curled paper.

» Do not mix paper types in a tray.

» Use only recommended print media. (see page 4.6)

» Ensure that the recommended side of the print media is facing down in
the tray.

3 Remove the jammed paper by gently pulling it straight out as shown
below.

Clearing paper jams

Refer to the table below to locate and clear the paper jam.

Status display Explanation Solution
In the paper feed area and Clear the jam.
rear the machine (Page 7.1)
Paper jam Rear and Inside the machine Clear the jam.
LED(8J\'.) blinks (Page 7.3)
In the exit area Clear the jam.
(Page 7.5)

To avoid tearing the paper, pull the jammed paper out gently
and slowly. Follow the instructions in the following sections to
clear the jam.
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4  Align the tray with the slot, and slide it into the machine.

Be careful not to pinch your fingers, since the top cover is very
heavy.
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5 Press the top cover lever, completely open the top cover.

7  If the paper jam LED blinks, go to next step.

8 Open the rear cover.
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6 Hold the top cover and close it slowly and carefully, until the cover is ) )
securely latched. 9 Carefully take the jammed paper out of the machine.

NN

Do not touch the fuser inside the machine. It is hot and could

Note cause burns! The fuser's operating temperature is very hot.
If the top cover is not completely closed, the machine will not Take care when removing paper from the machine.
operate.
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10 Hold both edges of the rear cover, and align it as shown in the
following figure. Press the rear cover firmly until it clicks.

—~
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Note

If the rear cover is not completely closed, the paper jam may
occur.

11 Open and close the top cover firmly. The machine will resume
printing.
Rear and inside the machine

If paper is jammed in the rear and inside the machine, follow the next
steps to release the jammed paper.

1 Open the rear cover.
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2 Carefully take the jammed paper out of the machine.
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Caution

Do not touch the fuser inside the machine. It is hot and could
cause burns! The fuser's operating temperature is very hot.
Take care when removing paper from the machine.

3 Hold both edges of the rear cover, and align it as shown in the
following figure. Press the rear cover firmly until it clicks.

—~
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Note
If the rear cover is not completely closed, the paper jam may
occur.
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4  Press the top cover lever, completely open the top cover. 7 Press the top cover lever, completely open the top cover.

8 Grasp the handles on the toner cartridge and pull to remove the
cartridge out of the machine.

5 Hold the top cover and close it slowly and carefully, until the cover is

securely latched. » Do not touch the green surface, the OPC drum or the front of

the toner cartridge, with your hands or any other material.
Use the handle on each cartridge in order to avoid touching
this area.

+ If you leave the top cover open for more than a few minutes,
the OPC drum can be exposed to light. This will cause
damage to the OPC drum. Close the top cover should the
installation need to be halted for any reason.

Note

If toner gets on your clothing, wipe it off with a dry

cloth and wash it in cold water. Hot water sets toner into
fabric.

9 Carefully take the jammed paper out of the machine.

Note
If the top cover is not completely closed, the machine will not
operate.

Be careful not to pinch your fingers, since the top cover is very
heavy.
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Do not touch the fuser inside the machine. It is hot and could
cause burns! The fuser's operating temperature is very hot.

6 Ifthe paper jam LED blinks, go to next step. Take care when removing paper from the machine.
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10 After removing the jammed paper, check for paper which may be
jammed in other parts of the machine.

11 Slide the toner cartridge back into the machine.

12 Close the top cover firmly. The machine will resume printing.

In the exit area

If paper is jammed in the paper exit area, follow the next steps to release
the jammed paper.

1 Press the top cover lever, completely open the top cover.

2

If there is any resistance removing the paper, stop pulling and go to
step 4.

Do not touch the fuser inside the machine. It is hot and could
cause burns! The fuser's operating temperature is very hot.
Take care when removing paper from the machine.
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3 Hold the top cover and close it slowly and carefully, until the cover is 4 Open the inner cover.
securely latched.

Note inner cover

If the top cover is not completely closed, the machine will not
operate.

Do not touch the fuser inside the machine. It is hot and could
cause burns! The fuser's operating temperature is very hot.

Be careful not to pinch your fingers, since the top cover is very Take care when removing paper from the machine.

heavy.
5 Carefully take the jammed paper out of the machine.
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6 Close the inner cover.

7  After removing the jammed paper, check for paper which may be
jammed in other parts of the machine.

8 Close the top cover firmly. The machine will resume printing.

7.6 <Troubleshooting>




Understanding display messages

Messages appear on the Smart Panel program window or on the control

panel display to indicate machine status or errors. Refer to the tables

below to understand the messages meaning to correct the problem, if

necessary.

Note

When you call for service, it is very convenient to provide the

service representative with the contents of the display message.

Status display

Explanation

Solution

OPEN

The covers is not
completely closed.

Press the covers until it
clicks.

There is a problem
in the machine.

Unplug the power cord
and plug it back in. If the

A LED blinks problem persists, contact
the service
representatives.

- . There is no paper in | Load paper in the tray.
E] LED blinks the tray. (Page 4.5)
In the paper feed Clear the jam. (Page 7.1)
area and rear the
machine.

8J\I' LED blinks Rear and Inside the | Clear the jam. (Page 7.3)

machine.

In the exit area.

Clear the jam. (Page 7.5)

|&] LEDblinks
slowly

Small amount of
toner is left in the
cartridge. The
estimated
cartridge life? of
toner is close.

Take out the
corresponding toner
cartridge and thoroughly
shake it. By doing this,
you can temporarily
reestablish printing
operations. (Page 8.4)

Status display

Explanation

Solution

| %] LEDblinks
rapidly

A toner cartridge
has almost
reached its
estimated
cartridge life.2

Replace the toner
cartridge for the best
print quality when this
message appears.
Using a cartridge
beyond this stage can
result in printing quality
issues. (See
"Replacing the toner
cartridge" on page 8.5.)

The toner cartridge
is installed
improperly, or not
installed.

Reinstall the toner
cartridge two or three
times. If the problem
persists, the toner
cartridge is not being
detected. Please contact
the service
representatives. (Page
6.5)

which the arrow
indicates is not a
Samsung-genuine
cartridge.

T1 The toner cartridge Install the a Samsung-
which the arrow genuine toner cartridge
indicates is not designed for your
suitable for your machine.
machine.
has almost replace the toner
reached its cartridge. (See
estimated "Replacing the toner
cartridge life.2 cartridge" on page 8.5.)

T3 The toner cartridge Replace the

corresponding toner
cartridge with a Samsung-
genuine cartridge.

(Page 6.5)

a. Estimated cartridge life means the expected or estimated toner cartridge life,
which indicates the average capacity of print-outs and is designed pursuant to
ISO/IEC 19752. (page 11.1) The number of pages may be affected by
operating environment, printing interval, media type, and media size. Some
amount of toner may remain in the cartridge even when the red LED turned on
and the printer stops printing.

Samsung does not recommend using non-genuine
Samsung toner cartridge such as refilled or
remanufactured. Samsung cannot guarantee non-
genuine Samsung toner cartridge's quality. Service or
repair required as a result of using non-genuine
Samsung toner cartridges will not be covered under the
machine warranty.
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Solving other problems

The following chart lists some conditions that may occur and the
recommended solutions. Follow the suggested solutions until the
problem is corrected. If the problem persists, please call for service.

Paper feeding problems

Condition

Suggested solutions

Paper is jammed
during printing.

Clear the paper jam. (See "Clearing paper
jams" on page 7.1.)

Paper sticks
together.

» Ensure that there is not too much paper in the

tray. The tray can hold up to 100 sheets of
paper.

Make sure that you are using the correct type
of paper. (See "Specifications on print
media" on page 4.3.)

Remove paper from the tray and flex or fan
the paper.

Humid conditions may cause some paper to
stick together.

Multiple sheets of
paper do not
feed.

Different types of paper may be stacked in the
tray. Load paper of only one type, size, and
weight.

If multiple sheets have caused a paper jam,
clear the paper jam. (See "Clearing paper
jams" on page 7.1.)

Paper does not
feed into the
machine.

Paper has not been loaded correctly. Remove
paper from the tray and reload it correctly.
There is too much paper in the tray. Remove
excess paper from the tray.

The paper is too thick. Turn the paper around
or upside down, and try again. Use only paper
that meets the specifications required by the
machine. (See "Specifications on print
media" on page 4.3.)

Remove any obstructions from inside the
machine.

The paper keeps
jamming.

There is too much paper in the tray. Remove
excess paper from the tray.

An incorrect type of paper is being used. Use
only paper that meets the specifications
required by the machine. (See "Specifications
on print media" on page 4.3.)

There may be debris inside the machine.
Open the top cover and remove the debris.

Printing problems

computer and the
machine is defective.

Condition Possible cause Suggested solutions
The machine is not Check the power cord
receiving power. connections. Check the

power switch and the power
source.
The machine is not Select a machine name as
selected as the your default printer in your
default printer. Windows.
Check the machine for the following:
» The cover is not closed. Close the cover.
» Paper is jammed. Clear the paper jam. (See
"Clearing paper jams" on page 7.1.)
* No paper is loaded. Load paper. (See "Loading
paper in the tray" on page 4.5.)
» The toner cartridge is not installed. Install the toner
cartridge.
If a system error occurs, contact your service
representative.
The connection cable | Disconnect the printer cable
between the and reconnect it.
computer and the
machine is not
The connected properly.
machine
does not The connection cable | If possible, attach the cable
print. between the to another computer that is

working properly and print a
job. You can also try using a
different printer cable.

The port setting is
incorrect.

Check the Windows printer
setting to make sure that the
print job is sent to the correct
port. If the computer has
more than one port, make
sure that the machine is
attached to the correct one.

The machine may be
configured
incorrectly.

Check the printer properties
to ensure that all of the print
settings are correct.

The printer driver
may be incorrectly
installed.

Repair the printer software.
See Software section.

The machine is
malfunctioning.

Check the display message
on the control panel to see if
the machine is indicating a
system error. Contact a
service representative.
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Condition

Possible cause

Suggested solutions

The The paper option that | For many software
machine was selected in the applications, the paper
selects print | machine properties source selection is found
materials may be incorrect. under the Paper tab within
from the the printer properties. Select
wrong the correct paper source.
paper See the printer driver help
source. screen.
A print job The job may be very Reduce the complexity of the
isextremely | complex. page or try adjusting the print
slow. quality settings such as
adjusting the resolution.
Half the The page orientation Change the page orientation
page is setting may be in your application. See the
blank. incorrect. printer driver help screen.
The paper size and Ensure that the paper size in
the paper size the printer driver settings
settings do not matches the paper in the
match. tray.
Or, ensure that the paper
size in the printer driver
settings matches the paper
selection in the software
application settings you use.
The The printer cable is Disconnect the printer cable
machine loose or defective. and reconnect. Try a print job
prints, but that you have already printed
the text is successfully. If possible,
wrong, attach the cable and the
garbled, or machine to another computer
incomplete. and try a print job that you

know works. Finally, try a
new printer cable.

The wrong printer
driver was selected.

Check the application’s
printer selection menu to
ensure that your machine is
selected.

The software
application is
malfunctioning.

Try printing a job from
another application.

The operating system
is malfunctioning.

Exit Windows and reboot the
computer. Turn the machine
off and then back on again.

Condition Possible cause Suggested solutions
Pagesprint, | The toner cartridge is Redistribute the toner, if
butthey are | defective or out of necessary.
blank. toner. If necessary, replace the

toner cartridge.
The file may have Check the file to ensure that
blank pages. it does not contain blank
pages.

Some parts, such as Contact a service

the controller or the representative.

board, may be

defective.
PDF file Incompatibility Printing the PDF file as an
does not between the PDF file | image may enable the file to
print and the Acrobat print. Turn on Print As Image
correctly- products. from the Acrobat printing
some parts options.
are missing Note: It will take longer to
in the print when you print a PDF
graphics, file as an image.
text or
illustrations.
The print The resolution of the Reduce the photo size. If you
quality of photo is very low. increase the photo size in the
photos is software application, the
not good. resolution will be reduced.
Images are
not clear.
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Printing quality problems

If the inside of the machine is dirty or paper has been loaded improperly,
you may notice a reduction in print quality. See the table below to clear

the problem.

Condition

Suggested solutions

Light or faded print

Aa~hCc

Aa~hCc
Aa~hCc
Aa~hCc

Aa~hCc

If a vertical white streak or faded area appears

on the page:

» The toner supply is low. You may be able to
temporarily extend the toner cartridge life. If
this does not improve the print quality, install
a new toner cartridge.

* The paper may not meet paper
specifications; for example, the paper may
be too moist or rough. (See "Specifications
on print media" on page 4.3.)

« If the entire page is light, the print resolution
setting is too low or the toner save mode is
on. Adjust the print resolution and turn the
toner save mode off. See the help screen of
the printer driver and refer to Software
section, respectively.

» A combination of faded or smeared defects
may indicate that the toner cartridge needs
cleaning. Contact a service representative.

» The surface of the LSU part inside the
machine may be dirty. Clean the LSU (see
page 6.2).

Toner specks

AaBbCc’

AaBbCe

‘Aai3bCc
AaBhCe.
AaknCc’

» The paper may not meet specifications; for
example, the paper may be too moist or
rough. (See "Specifications on print
media" on page 4.3.)

» The paper path may need cleaning. Contact
a service representative.

Dropouts

AaBbCc
AaBbCc
AaBbCoc
AaBbCc
AaBb(Cc

If faded areas, generally rounded, occur
randomly on the page:

» A single sheet of paper may be defective.
Try reprinting the job.

» The moisture content of the paper is uneven
or the paper has moist spots on its surface.
Try a different brand of paper. (See
"Specifications on print media" on page 4.3.)

» The paper lot is bad. The manufacturing
processes can cause some areas to reject
toner. Try a different kind or brand of paper.

« If these steps do not correct the problem,
contact a service representative.

Condition

Suggested solutions

White Spots

White spots appear on the page:

» The paper path may need cleaning. Contact
a service representative.

Vertical lines

AaBbCq
AaBb(Cq
AaBbCq
AaBb(Cc

VG777

AaBbCa

If black vertical streaks appear on the page:

» The toner cartridge has probably been
scratched. Remove the toner cartridge and
install a new one.

If white vertical streaks appear on the page:

» The surface of the LSU part inside the
machine may be dirty. Clean the LSU (see
page 6.2).

Color or Black
background

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc

If the amount of background shading becomes
unacceptable:

» Change to a lighter weight paper. (See
"Specifications on print media" on page 4.3.)

» Check the environmental conditions: very
dry conditions (low humidity) or a high level
of humidity (higher than 80% RH) can
increase the amount of background
shading.

* Remove the old toner cartridge, and then
install a new one. (See "Replacing the toner
cartridge" on page 6.5.)

Toner smear

AaBbCc
AaBhCc
AaBhCc
AaBbCc
AaBbCc

 Clean the inside of the machine. Contact a
service representative to clean the inside of
the machine.

» Check the paper type and quality. (See
"Specifications on print media" on page 4.3.)
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Condition

Suggested solutions

Vertical repetitive
defects

AaBch’
AaBbCc_
AaBbCc
AaBch’

AaBbCc

If marks repeatedly appear on the printed side

of the page at even intervals:

 Clean the inside of the machine. Contact a
service representative to clean the inside of
the machine. After cleaning the inside of the
machine, if you still have the same
problems, install a new toner cartridge of the
problem color. See "Replacing the toner
cartridge" on page 6.5.

» Parts of the machine may have toner on
them. If the defects occur on the back of the
page, the problem will likely correct itself
after a few more pages.

» The fusing assembly may be damaged.
Contact a service representative.

Background scatter

Background scatter results from bits of toner
randomly distributed on the printed page.

* The paper may be too damp. Try printing
with a different batch of paper. Do not open
packages of paper until necessary so that
the paper does not absorb too much
moisture.

« If background scatter covers the entire
surface area of a printed page, adjust the
print resolution through your software
application or in printer properties.

Misformed « If characters are improperly formed and
characters producing hollow images, the paper stock
may be too slick. Try different paper. (See

AaBbCc "Specifications on print media" on page 4.3.)
AaBbCc « If characters are improperly formed and
AaBbCc producing a wavy effect, the scanner unit
AaBbCc may need service. Contact a service
AaBbCc representative.
AaBbCc

Page skew » Ensure that the paper is loaded properly.

AaBpc

AaBbcg
AaBbC,
AaBbC,
AaBbC,

» Check the paper type and quality. (See
"Specifications on print media" on page 4.3.)

* Ensure that the paper or other material is
loaded correctly and the guides are not too
tight or too loose against the paper stack.

Condition

Suggested solutions

Curl or wave

« Ensure that the paper is loaded properly.

» Check the paper type and quality. Both high
temperature and humidity can cause paper
curl. (See "Specifications on print media" on
page 4.3.)

» Turn the stack of paper over in the tray. Also
try rotating the paper 180° in the tray.

* Ensure that the paper is loaded properly.

» Check the paper type and quality. (See
"Specifications on print media" on page 4.3.)

» Turn the stack of paper over in the tray. Also
try rotating the paper 180° in the tray.

Back of printouts
are dirty

AaBbCc
AaBbCc
AaBbCc
AaBbCc
BbCc

Check for leaking toner. Clean the inside of
the machine. Contact a service
representative.

Black pages

» The toner cartridge may not be installed
properly. Remove the cartridge and reinsert
it.

» The toner cartridge may be defective and
need replacing. Remove the toner cartridge
and install a new one. (See "Replacing the
toner cartridge" on page 6.5.)

» The machine may require repair. Contact a
service representative.
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Condition

Suggested solutions

Loose toner

AaBb(Cc
AaBbCc

 Clean the inside of the machine. Contact a
service representative to clean the inside of
the machine. After cleaning the inside of the
machine, if you still have the same
problems, contact a service representative.

» Check the paper type and quality. (See
"Specifications on print media" on page 4.3.)

* Remove the toner cartridge, and then install
a new one. (See "Replacing the toner
cartridge" on page 6.5.)

« If the problem persists, the machine may
require repair. Contact a service
representative.

Character Voids

Character voids are white areas within parts of
characters that should be solid black:

« If you are using transparencies, try another
type of transparency. Because of the
composition of transparencies, some
character voids are normal.

* You may be printing on the wrong surface of
the paper. Remove the paper and turn it
around.

» The paper may not meet paper
specifications. (See "Specifications on print
media" on page 4.3.)

Horizontal stripes
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If horizontally aligned black streaks or smears
appear:

» The toner cartridge may be installed
improperly. Remove the cartridge and
reinsert it.

» The toner cartridge may be defective.
Remove the toner cartridge and install a
new one. (See "Replacing the toner
cartridge" on page 6.5.)

« If the problem persists, the machine may
require repair. Contact a service
representative.

Curl

If the printed paper is curled or paper does not

feed into the machine:

» Turn the stack of paper over in the tray. Also
try rotating the paper 180° in the tray.

Condition

Suggested solutions

An unknown image
repetitively appears
on the next few
sheets or loose
toner, light print, or
contamination
occurs.

You machine is probably being used at an
altitude of 1,000 m (3,281 ft) or above. The
high altitude may affect the print quality from
loose toner or light imaging. You can set this
option through the Printer Tab in printer
driver’s properties. See page 3.9.

Common Windows problems

Condition

Suggested solutions

“File in Use”
message appears
during installation.

Exit all software applications. Remove all
software from the StartUp Group, then restart
Windows. Reinstall the printer driver.

“General
Protection Fault”,
“Exception OF”,
“Spool32”, or
“lllegal Operation”
messages appear.

Close all other applications, reboot Windows
and try printing again.

“Fail To Print”, “A
machine timeout
error occurred.”
messages appear.

These messages may appear during printing.
Just keep waiting until the machine finishes
printing. If the message appears in standby
mode or after printing has been completed,
check the connection and/or whether an error
has occurred.

Note

Refer to Microsoft Windows User’s Guide that came with your
computer for further information on Windows error messages.
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Common Linux problems

Condition

Suggested solutions

The printer doesn’t
print.

» Check if the printer driver is installed in your
system. Open Unified Driver Configurator
and switch to the Printers tab in Printers
configuration window to look at the list of
available printers. Make sure that your
machine is displayed on the list. If not,
please, invoke Add new printer wizard to set
up your device.

» Check if the printer is started. Open Printers
configuration and select your machine on
the printers list. Look at the description in
the Selected printer pane. If its status
contains “(stopped)” string, please, press
the Start button. After that normal operation
of the printer should be restored. The
"stopped" status might be activated when
some problems in printing occurred.

» Check if your application has special print
option such as “-oraw”. If “-oraw” is
specified in the command line parameter
then remove it to print properly. For Gimp
front-end, select “print” -> “Setup printer”
and edit command line parameter in the
command item.

| encounter error
“Unable to open
mfp port device
file!” when printing
a document.

Please avoid changing print job parameters
(via LPR GUI, for example) while a print job is
in progress. Known versions of CUPS server
break the print job whenever print options are
changed and then try to restart the job from
the beginning. Since Unified Linux Driver
locks mfp port while printing, the abrupt
termination of the driver keeps the port locked
and therefore unavailable for subsequent print
jobs. If this situation occurred, please, try to
release the mfp port.

When printing a
document over the
network in SUSE
9.2, the printer
does not print.

The CUPS (Common Unix Printing System)
version distributed with SUSE Linux 9.2
(cups-1.1.21) has a problem with ipp
(Internet Printing Protocol) printing. Use the
socket printing instead of ipp or install later
version of CUPS (cups-1.1.22 or higher).

Common Macintosh problems

Problem

Suggested solutions

PDF file does not print
correctly-some parts are
missing in the graphics,
text or illustrations.

Incompatibility between the PDF file and
the Acrobat products.

Printing the PDF file as an image may
enable the file to print. Turn on Print As
Image from the Acrobat printing options.
Note: It will take longer to print when
you print a PDF file as an image.

The document has
printed, but the print job
has not disappeared from
the spooler in

Mac OS 10.3.2.

Update your Mac OS to OS 10.3.3. or
higher.

Some fonts are not
printed properly in the
Adobe lllustrator
program.

Those fonts may not supported by your
machine. Start the Adobe lllustrator
program, click File > Print > lllustrator
tab. Then, check Force Fonts to
Download, and try again.
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8 Ordering supplies and
accessories

This chapter provides information on purchasing cartridges and
accessories available for your machine.

This chapter includes:
e Supplies
* How to purchase

Supplies

Note

The optional parts or features may differ by countries. Contact
your sales representatives whether the part you want is
available in your country.

When the toner runs out, you can order the following type of toner
cartridge for your machine:

Type Average yield? Part number
Standard yield | Average cartridge ML-D1630A
yield 2,000 standard
pages.

a. Declared yield value in accordance with ISO/IEC 19752.

Caution

When you purchase a new toner cartridge or supplies, you must
purchase them in the same country you have purchased your
machine. Otherwise, the toner cartridge or supplies will be
incompatible with your machine since the configuration of the
toner cartridge or supplies vary depending on the countries.

How to purchase

To order Samsung-authorized supplies or accessories, contact your local
Samsung dealer or the retailer where you purchased your machine, or
visit www.samsungprinter.com and select your country/region to obtain
information on calling for technical support.
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9 Specifications

This chapter includes:

» General specifications

» Printer specifications

Note

The numbers herein is subject to change according to its install

environment.

General specifications

Iltem Specifications and Description
Paper input 100 multi-pages forflain paper
capacity? (20 Ib bond, 75 g/m*)
Paper output 30 sheets (face up)
capacity

Consumables

1-piece toner cartridge system

Power rating

AC 110-127 Vor AC 220 - 240V

See the Rating label on the machine for the
correct voltage, frequency (hertz) and type of
current for your machine.

Power Average operation mode: Less than 350 W
consumption Sleep mode: Less than 8.12 W
Power off mode: 0 W
Noise level” Standby mode: Less than 38 dBA
Operating Temperature: 10 °Ct0 32 °C (50 ° F t0 89.6 ° F )

environment

Humidity: 20% to 80% RH

Display

Blue LED Module (65EA Dots)

toner cartridge
yield®

Standard Yield: Average cartridge yield 2,000
standard pages.

(Ships with 1,000 pages Starter/Standard
Toner Cartridge) ¢

** Declared yield value in accordance with
ISO/IEC 19752.

Memory

8 MB (Non-extendable)

External dimension
(W xDxH)

332 x 375 x 121.5mm
(13.1 x 14.8 x 4.8 inches)

Weight

6.95 Kg (15.32 Ibs)
(including consumables)

Iltem Specifications and Description
Paper: 1.1 Kg (2.431 Ibs)
Package weight
Plastic: 0.271 Kg (0.60 Ibs)

a.For details about paper input capacity, see page 4.3.

b. Sound Pressure Level, ISO 7779

c. Average cartridge yield declared in accordance with ISO/IEC 19752. The
number of pages may be affected by the operating environment, printing
interval, media type, and media size.

d. It varies depending on the product configuration.

Printer specifications

Item

Description

Printing method

Laser Beam Printing

Printing speed?®

Up to 16 ppm in A4 (17 ppm in Letter)

First print out time

from coldboot: Less than 15 seconds

Print resolution

Up to 1200 dpi class(Best) Effective output

Printer language

SPL (Samsung Printer Language)

OS compatibility &
driver®

Windows 2000/XP/2003/2008/Vista/7/Server
2008 R2, Various Linux OS, Mac 10.3 ~ 10.6

Interface

USB 2.0
Ethernet 10/100 Base TX
802.11 b/g Wireless LAN

a. Print speed will be affected by operating system used, computing performance,
application software, connect on method, media type, media size, and job

complexity.

b. Please visit www.samsungprinter.com to download the latest software version.
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10 Glossary

Control Panel

A control panel is a flat area where control or monitoring instruments are
displayed. They are typically found in top or front of the machine.

Coverage

This is the printing term used for toner usage measurement on printing
and generally used as 5% coverage. 5% coverage means that an A4
sided paper has about 5% image or text on it. So, if the paper or original
has complicated images or lots of text on it, the coverage will be over 5%
and at the same time, toner usage will be as much as the coverage.

Default

The first set values.

DPI

This is the measurement of resolution which is used for printing or
scanning. Generally, more dots per inch result in a higher resolution,
more visible detail in the image, and a larger file size.

Duty Cycle

Duty cycle is the page quantity which does not affect printer performance
for a month. Generally the printer has the lifespan limitation such as
pages per year. The lifespan means the average capacity of print-outs,
usually within the warranty period. For example, if the duty cycle is 48,000
pages per month assuming 20 working days, a printer limits 2,400 pages
a day, which is not small amount.

Fuser Unit

This is the part of a laser printer that melts the toner onto the print media.
It consists of two hot rollers. After toner is transferred onto the paper, the
fuser unit applies heat and pressure to ensure that the toner stays on the
paper permanently, which is why paper is warm when it comes out of a

laser printer.

Grayscale

Shades of gray that represent light and dark portions of an image when
color images are converted to grayscale; colors are represented by
various shades of gray.

Halftone

This is an image type that simulates grayscale by varying the number of
dots. Highly colored areas consist of a large number of dots, while lighter
areas consist of a smaller number of dots.

ISO

The International Organization for Standardization (ISO) is an
international standard-setting body composed of representatives from
national standards bodies. It produces world-wide industrial and
commercial standards.

LED

A light-emitting diode (LED) is a semiconductor device that indicates the
status of a machine.

Print Media

Media such as papers, labels, and transparencies which can be used on
a printer, a scanner, a fax or, a copier.

OPC Drum

A mechanism that makes a virtual image for print using a laser beam
emitted from a laser printer, and it is usually green or gray-colored and
cylinder-shaped. An exposing unit of a drum is slowly worn away by its
usage of the printer, and it should be replaced appropriately since it
becomes scratched from grit in paper.

PDF

Portable Document Format (PDF) is a proprietary file format developed
by Adobe Systems for representing two-dimensional documents in a
device-independent and resolution-independent format.

PPM

Pages Per Minute. PPM shows the printer's speed, how many pages a
printer can actually print per minute.

PRN file

An interface for a device driver, this allows software to interact with the
device driver using standard input/output system calls, which simplifies
many tasks.

Resolution

The sharpness of an image, measured in dots per inch (dpi). The higher
the dpi, the greater the resolution.

Toner cartridge

It is a kind of bottle within a machine like a printer which contains toner.
Toner is a powder used in laser printers and photocopiers which forms the
text and images on the printed paper. Toner can be melted by the heat of
the fuser, causing it to bind to the fibers in the paper.

URL

Uniform Resource Locator (URL) is the global address of documents and
resources on the Internet. The first part of the address indicates what
protocol to use, the second part specifies the IP address or the domain
name where the resource is located.

USB

Universal serial bus (USB) is a standard that was developed by the USB
Implementers Forum, Inc., to connect computers and peripherals. Unlike
the parallel port, USB is designed to concurrently connect a single
computer USB port to multiple peripherals.
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Installing Printer
Software in Windows

This chapter includes:
« Installing Printer Software
= Reinstalling Printer Software

< Removing Printer Software

NoOTE: The following procedure is based on Windows XP, for
other operating systems, refer to the corresponding Windows
user's guide or online help.

Installing Printer Software

You can install the printer software for local printing or network
printing. To install the printer software on the computer,
perform the appropriate installation procedure depending on
the printer in use.

A printer driver is software that lets your computer
communicate with your printer. The procedure to install drivers
may differ depending on the operating system you are using.

All applications should be closed on your PC before beginning
installation.

Installing Software for Local Printing

A local printer is a printer directly attached to your computer
using the printer cable supplied with your printer, such as a USB
or parallel cable. If your printer is attached to a network, skip
this step and go to “Installing Software for Network Printing” on
page 7.

You can install the printer software using the typical or custom
method.

NoOTE: If the “New Hardware Wizard” window appears during
the installation procedure, click x| in the upper right corner of
the box to close the window, or click Cancel.

4

Typical Installation

This is recommended for most users. All components necessary
for printer operations will be installed.

1 Make sure that the printer is connected to your computer
and powered on.

2 Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation
window appears.

If the installation window does not appear, click Start and
then Run. Type X:\Setup.exe, replacing “X” with the
letter which represents your drive and click OK.

If you use Windows Vista, Windows 7 and Windows Server
2008 R2, click Start —» All programs — Accessories —
Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista,
Windows 7 and Windows Server 2008 R2, click Run
Setup.exe in Install or run program field, and click
Continue in the User Account Control window.

3 Click Next.

Itis strongly recommended that you quit allwWindows applications before
running Setup.

Wiew User's Guide |

Select a language from the list below,

English ~|

< If necessary, select a language from the drop-down list.

« View User’s Guide: Allows you to view the User’s
Guide. If your computer doesn’t have Adobe Acrobat,
click on this option and it will automatically install Adobe
Acrobat Reader for you.

Installing Printer Software in Windows



4 Select Typical installation for a local printer. Click

Next.

Select Installation Type

Select type that you want and click [Mext] button,

& Typical installation for a

loeal printer
computer

- Typical installation fora
network printer

€ Custam installaion
professional users.

Inztall default comporents for a device that is directly connected to uger's

Inztall software for a device that iz on network Wired or Wireless|

“Y'ou can select ingtallation options. This option iz recommended for

{Back | Nexts I Cancel

NOTE: If your printer is not already connected to the

computer, the following window will appear.

Connect Device

Setup can not find a connected device. Check connection between your computer and
the printer

<P

Please refer ta the following connection methad.
1. Connect the device to your computer

2. Tumn on the power of the device

3. IF"New Hardware Wizard" is appeared, cloze it.

4. Click [Nest]

<Back | T hets I Cancel |

= After connecting the printer, click Next.
= If you don’t want to connect the printer at this time, click

Next, and No on the following screen. Then the installation
will start and a test page will not be printed at the end of the

installation.

= The installation window that appears in this User’s
Guide may differ depending on the printer and
interface in use.

5 After the installation is finished, a window asking you to
print a test page appears. If you choose to print a test
page, select the checkbox and click Next.

Otherwise, just click Next and skip to step 7.

6 If the test page prints out correctly, click Yes.

If not, click No to reprint it.

To register yourself as a user of Samsung Printers in order
to receive information from Samsung, select the checkbox

5

and click Finish. You are now sent to the Samsung web
site.

Otherwise, just click Finish.

Setup Completed

Or-line Registration
Yo will get the opportunity to receive free newsletters with exclusive tips
and promotions. Also wou wil get more customer care.

Would you like ta register for the Samsung Printer Membership?

SAMSUNE

NOTE: After setup is complete, if your printer driver doesn’t
work properly, reinstall the printer driver. See “Reinstalling
Printer Software” on page 11.

Custom Installation

You can choose individual components to install.

1

2

Make sure that the printer is connected to your computer
and powered on.

Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation
window appears.

If the installation window does not appear, click Start and
then Run. Type X:\Setup.exe, replacing “X” with the
letter which represents your drive and click OK.

If you use Windows Vista, Windows 7 and Windows Server
2008 R2, click Start —» All programs — Accessories —
Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista,
Windows 7 and Windows Server 2008 R2, click Run
Setup.exe in Install or run program field, and click
Continue in the User Account Control window.

Installing Printer Software in Windows



3 Click Next.

Itis strangly recommended that you quit all ‘Windows applications before
running Setup,

Wiew User's Guide |

Select a language from the list below.

English ~|

« If necessary, select a language from the drop-down list.

= View User’s Guide: Allows you to view the User’s
Guide. If your computer doesn’'t have Adobe Acrobat,
click on this option and it will automatically install Adobe
Acrobat Reader for you.

4  Select Custom installation. Click Next.

Select Installation Type W

Select type that you want and click [Mext] buttan,

Typical installation for a

o : A
local printer Install default components for a device that is directly connected to user's

computer

r Typical installation for a

network printer Install software for a device that is on network [wired or Wirsless]

& Custom installation “Y'ou can select installation options. This option is recommended for
professional users.

Back | [ Wt | Concel

5 Select your printer and click Next.

Select Printer Port w
Select a port that will be used far paur printer
% Local or TCPAP Part

" Shared Printer (LINT)
" tdd TCPAP Port

Select a printer from the list below. If you don't see your printer belaw, click. [Update] to refresh the list

Printer Mame | |P/Part Mame

WOTE: If 5 firewall has been enabled an this PC, this may be prewenting the installer from Update
detecting the printer. Temporarily disable the firewall on this PC betore continuing with the
installation,

<Back. | Hexts I Cancel |

6

NOTE: If your printer is not already connected to the

computer, the following window will appear.

%]

the printer

Connect Device
Setup can not find a connected device. Check connection between your computer and

Pleaze refer ta the following conhection methad.
1. Connect the device to your computer

2. Turh on the power of the device

3. It "New Hardware 'wizard" iz appeared, close it

4. Click [Next]

= After connecting the printer, click Next.

< If you don’t want to connect the printer at this time, click
Next, and No on the following screen. Then the installation
will start and a test page will not be printed at the end of the

installation.

= The installation window that appears in this User’s
Guide may differ depending on the printer and

interface in use.

6 Select the components to be installed and click Next.

%]

Select components that you would like to install W

—Select component

Select components that you would like to install

r~Chanoe Destination Folder

@—

Browse

<Back | Next> I Cancel

NOTE: You can change the desired installation folder by

clicking [Browse].

7 After the installation is finished, a window asking you to
print a test page appears. If you choose to print a test

page, select the checkbox and click Next.
Otherwise, just click Next and skip to step 9.

8 If the test page prints out correctly, click Yes.

If not, click No to reprint it.
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9 To register yourself as a user of Samsung Printers in order | nstalling Software for Network
to receive information from Samsung, select the checkbox . .
Printing

and click Finish. You are now sent to the Samsung web

site. When you connect your printer to a network, you must first

Otherwise, just click Finish. configure the TCP/IP settings for the printer. After you have
assigned and verified the TCP/IP settings, you are ready to
install the software on each computer on the network.

Setup Completed You can install the printer software using the typical or custom

method.

Onvline Registration
“'ou will get the oppartunity to receive free newsletters with exclusive tips
and promations. Also you will get more customer care.

Typical Installation
“Would pou like to register for the Samsung Frinter Membership?

This is recommended for most users. All components necessary
for printer operations will be installed.

1 Make sure that the printer is connected to your network
and powered on. For details about connecting to the
network, see the supplied printer’s User’s Guide.

2 Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation
window appears.

If the installation window does not appear, click Start and
then Run. Type X:\Setup.exe, replacing “X” with the
letter which represents your drive and click OK.

If you use Windows Vista, Windows 7 and Windows Server
2008 R2, click Start — All programs — Accessories —»
Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista,
Windows 7 and Windows Server 2008 R2, click Run

Setup.exe in Install or run program field, and click
Continue in the User Account Control window.

3 Click Next.

It iz strangly recommended that pou quit all Windaws applications befare
unning 5 etup,

View User's Guide |

Select a language from the list below.

English |

« If necessary, select a language from the drop-down list.

« View User’s Guide: Allows you to view the User’s
Guide. If your computer doesn’t have Adobe Acrobat,
click on this option and it will automatically install Adobe
Acrobat Reader for you.

7
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4 Select Typical installation for a network printer. Click
Next.

Select Installation Type W

Select type that you want and click [Mext] button.

~ Typical installation for &

local printer Install default components for a device that is directly connected to user's

computer

¢ Topical installation for 3

etk printen Install software for a device that is on network [wired or Wireless]

" Custom installation You can select installation options. This option is recommended for
professional users.

{Back l Mexts | Cancel

NOTE: If your printer is not connected to the network, the
following window will appear. Select a setup option you want,
click Next.

No printer was found on the network w

“Werify that the printer iz properly connected with wired network. cable and tuned on before
proceeding installation.

Select a setup option belov.

% First time wired network printer installatior

Selecting this option will allove you to configure IF settings for your printer and install the printer on
your PC

" Wirgless settings on printer

Selecting this option will allow you to configure IP and Wireless settings for your printer and install
the printer on your PC.

Then the Set IP Address window appears. Do as follows:

x|
Set IP Address W
“Y'ou can sef or change P addiess for the network printer
Frinter Name | IP address MaL Address ~
ad
< | &
Informatiors Update |
Frinter MAC Address |
IP Address :
Configure
Subnet Mask
Default Gateveay

«Back | ‘ Cancel |

1.Select a printer to be set with a specific IP address from the
list.

8

2.Configure an IP address, subnet mask, and gateway for the
printer manually and click Configure to set the specific IP
address for the network printer.

3.Click Next, and go to step 6.

« You can also set the network printer via SyncThruTM Web
Service, an embedded web server. Click Launch SWS on
Set IP Address window. Your machine’s embedded website
opens.

5 The list of printers available on the network appears.
Select the printer you want to install from the list and then
click Next.

Select Printer Port W
Select a part that will be used for your printer
(=" TCP/IP Port

" Shared Printer [UNC]
" Add TCPAP Port

Select 5 printer from the list belaw. IF you don't see pour printer below, click [Update] ta refresh the list

Frinter Wame IP/Part Name

MOTE: If a firewall has been enabled on this PC. this may be preventing the installer from Update
detecting the printer. Temporarily dizable the firewall on this PC before continuing with the
irestallation.

<Back ‘ | Cancel |

= If you do not see your printer on the list, click Update to
refresh the list, or select Add TCP/IP Port to add your
printer to the network. To add the printer to the
network, enter the port name and the IP address for the
printer.

To verify your printer’s IP address or the MAC address,
print a Network Configuration page.

= To find a shared network printer (UNC Path), select
Shared Printer [UNC] and enter the shared name
manually or find a shared printer by clicking the Browse
button.

NOTE: If you cannot find your machine in network, please turn
off the firewall and click Update.

For Windows operating system, click Start —» Control Panel
and start windows firewall, and set this option unactivated. For
other operating system, refer to its on-line guide.

6 After the installation is finished, a window appears asking
you to print a test page and to register yourself as a user
of Samsung Printers in order to receive information from
Samsung. If you so desire, select the corresponding
checkbox(es) and click Finish.
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Otherwise, just click Finish.

Setup Completed

On-line Registration
“'ou will get the opportunity to receive free newsletters with exclusive tips
and promations. Alsa pou will get more custormer care,

‘Wiould you like to register far the Samsung Printer Membership?

[~ I'dlike to print a test page.

SAMSUNE

NOTE: After setup is complete, if your printer driver doesn’t
work properly, reinstall the printer driver. See “Reinstalling
Printer Software” on page 11.

Custom Installation

You can choose individual components to install and set a
specific IP address.

1 Make sure that the printer is connected to your network
and powered on. For details about connecting to the
network, see the supplied printer’s User’s Guide.

2 Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation
window appears.

If the installation window does not appear, click Start and
then Run. Type X:\Setup.exe, replacing “X” with the
letter which represents your drive and click OK.

If you use Windows Vista, Windows 7 and Windows Server
2008 R2, click Start — All programs — Accessories —
Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista,
Windows 7 and Windows Server 2008 R2, click Run
Setup.exe in Install or run program field, and click
Continue in the User Account Control window.
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Click Next.

Itiz strongly recommended that you quit &ll Windows applications before
nning Setup.

Wiew User's Guide I

Select a language from the list below.

[Engish E

or_|

« If necessary, select a language from the drop-down list.

« View User’s Guide: Allows you to view the User’s
Guide. If your computer doesn’t have Adobe Acrobat,
click on this option and it will automatically install Adobe
Acrobat Reader for you.

Select Custom installation. Click Next.

X
Select Installation Type w

Select type that you want and click [Mext] buttan.

- Typical installation for a

! )
local printer Irsstall detault components for a device that is directly connected to user's

computer

e Typical installation for a

i e Install software far a device that is on network (wWired or Wireless)

' Custom installation “fou can select installation options. This option is recommended for
profeszsional uzers.

Back [ [ Wew | coel |

5 The list of printers available on the network appears.

Select the printer you want to install from the list and then
click Next.

(%]

Select Printer Port W
Select a port that will be used for your printer

& Local o TCPAP Port

™ Shared Printer [UNC]

" fdd TCPAP Port

Select a printer from the list below. |f pou don't see pour printer below, click [Update] to refresh the list

Printer Name I |P/Part Mame

NOTE: If a firewall has been enabled on this PC, this may be preventing the: installer from Update
detecting the printer. Temporarily disable the firewall on this PC before continuing with the
installation

Set IP Address <Back | st I Cancel |
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= If you do not see your printer on the list, click Update to
refresh the list, or select Add TCP/IP Port to add your
printer to the network. To add the printer to the
network, enter the port name and the IP address for the
printer.

To verify your printer’s IP address or the MAC address,
print a Network Configuration page.

« To find a shared network printer (UNC Path), select
Shared Printer [UNC] and enter the shared name
manually or find a shared printer by clicking the Browse
button.

NoOTE: If you cannot find your machine in network, please turn
off the firewall and click Update.

For Windows operating system, click Start —» Control Panel
and start windows firewall, and set this option unactivated. For
other operating system, refer to its on-line guide.

TiP: If you want to set a specific IP address on a specific
network printer, click the Set IP Address button. The Set IP
Address window appears. Do as follows:

3
Set IP Address w
You can zet or change P address far the netwark. printer
Printer Name | IP Address I MAL Address |
b
3] | &
rInformation Update |
Frinter MAC Address I
IP Address : I . .
Configure
Subnet Mask : I . .
Default Gateway I . .
Launch S5 | <Back I Hext> | Cancel |

a. Select a printer to be set with a specific IP address from the
list.

b. Configure an IP address, subnet mask, and gateway for the
printer manually and click Configure to set the specific IP
address for the network printer.

c. Click Next.

* You can also set the network printer via SyncThruTM Web
Service, an embedded web server. Click Launch SWS on
Set IP Address window. Your machine’s embedded website
opens.
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6 Select the components to be installed. After selecting the
components, the following window appears. You can also
change the printer name, set the printer to be shared on
the network, set the printer as the default printer, and
change the port name of each printer. Click Next.

Set Printer w

Change printer settings to be installed

Printer Mame I Port | Detault F‘linterl Shared Mame |

‘Y'ou can change the printer name by selecting the name and entering a new name in the Printer
Mame Field.If pou want other users on the network. to access this printer, click the check box in
Share Name field and enter a share name that users will easily identify. IF you want this printer to
be the default printer, click the button in Default field.

[ Setting up this printer oh a server

<Back I Next> | Cancel |

To install this software on a server, select the Setting up
this printer on a server checkbox.

7 After the installation is finished, a window appears asking
you to print a test page and to register yourself as a user
of Samsung Printers in order to receive information from
Samsung. If you so desire, select the corresponding
checkbox(es) and click Finish.

Otherwise, just click Finish.

Setup Completed

Orvline Registration
You will get the appartunity to receive free newsletters with exclusive tips
and promations. Also you will get more customer care.

“would you like to register for the S amsung Printer Membership?

™ I'dlike to print a test page:

SAMSUNG

NOTE: After setup is complete, if your printer driver doesn’t
work properly, reinstall the printer driver. See “Reinstalling
Printer Software” on page 11.
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Reinstalling Printer Software

You can reinstall the software if installation fails.

1

2
3
4

Start Windows.

From the Start menu select Programs or All Programs
— your printer driver name — Maintenance.

Select Repair and click Next.

The list of printers available on the network appears.
Select the printer you want to install from the list and then
click Next.

(X

Select Printer Port w
Select a port that will be used for your printer
* Local or TCPAP Port

" Shared Printer [UNC)
" Add TCP/IP Port

Select & printer from the list belaw. IF you don't zee your printer belaw, click [Update] ta refresh the list.

Frinter Hame IP#Port Name

MOTE: If a firewall has been enabled on this PC, this may be preventing the installer from Update
detecting the printer. Temporarily disable the fireveall on this PC before continuing with the
installation

<Back ‘ Cancesl ‘

= If you do not see your printer on the list, click Update to
refresh the list, or select Add TCP/IP Port to add your
printer to the network. To add the printer to the
network, enter the port name and the IP address for the
printer.

« To find a shared network printer (UNC Path), select
Shared Printer [UNC] and enter the shared name
manually or find a shared printer by clicking the Browse
button.

You will see a component list so that you can reinstall any
item individually.

NOTE: If your printer is not already connected to the
computer, the following window will appear.

—_— _

Connect Device
Setup can not find a connected device. Check connection between your computer and

the printer

Pleaze refer ta the following connection methad,
1. Connect the device to your computer

2. Tumn an the pawer of the device

3. If "Mew Hardware Wizard" is appeared, close it

4. Click [Next]

<Back Cancel
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« After connecting the printer, click Next.

< If you don’t want to connect the printer at this time, click
Next, and No on the following screen. Then the installation
will start and a test page will not be printed at the end of the
installation.

= The reinstallation window that appears in this User’s

Guide may differ depending on the printer and
interface in use.

5 Select the components you want to reinstall and click
Next.

If you installed the printer software for local printing
and you select your printer driver name, the window
asking you to print a test page appears. Do as follows:

a. To print a test page, select the check box and click
Next.

b. If the test page prints out correctly, click Yes.

If it doesn’t, click No to reprint it.
6 When the reinstallation is done, click Finish.

Removing Printer Software

1 start Windows.

2 From the Start menu select Programs or All Programs
— your printer driver name — Maintenance.

3 Select Remove and click Next.
You will see a component list so that you can remove any
item individually.

4 Select the components you want to remove and then click
Next.

5 When your computer asks you to confirm your selection,
click Yes.
The selected driver and all of its components are removed
from your computer.

6 After the software is removed, click Finish.
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2 Basic Printing

This chapter explains the printing options and common printing
tasks in Windows.
This chapter includes:
< Printing a Document
< Printing to a file (PRN)
= Printer Settings
- Layout Tab
- Paper Tab
- Graphics Tab
- Extras Tab
- About Tab
- Printer Tab
- Using a Favorite Setting

- Using Help

Printing a Document

NOTES:

= Your printer driver Properties window that appears in this
User’s Guide may differ depending on the printer in use.
However the composition of the printer properties window is
similar.

= Check the Operating System(s) that are compatible
with your printer. Please refer to the OS Compatibility
section of Printer Specifications in your Printer User’s
Guide.

« If you need to know the exact name of your printer, you can
check the supplied CD-ROM.

The following procedure describes the general steps required
for printing from various Windows applications. The exact steps
for printing a document may vary depending on the application
program you are using. Refer to the User’s Guide of your
software application for the exact printing procedure.
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1 oOpen the document you want to print.

2 Select Print from the File menu. The Print window is
displayed. It may look slightly different depending on your
application.

The basic print settings are selected within the Print
window. These settings include the number of copies and

print range.
Print EE
~ Printer
Nore: [ ~|  Foveries.. |
Statuz.  Ready
Type: Make sure that your
Wwhere: printer is selected.
et ™ Prinit ta file
i~ Print range i~ Copies
(O] Mumber of copies: |'| 3:
- m ey T
| A, : RE 17| GallEte
ITI Cancel |

3 Select your printer driver from the Name drop-down
list.
To take advantage of the printer features provided by your
printer driver, click Properties or Preferences in the
application’s Print window. For details, see “Printer
Settings” on page 13.
If you see Setup, Printer, or Options in your Print
window, click it instead. Then click Properties on the next
screen.
Click OK to close the printer properties window.

4 To start the print job, click OK or Print in the Print
window.



Printing to a file (PRN)

You will sometimes need to save the print data as a file for your
purpose.

To create a file:
1 cCheck the Print to file box at the Print window.

Print EE
— Printer
oo [ -] | o |
Statuz.  Ready
Type:
‘where:

Comment: ™ Prirt ta file I
i~ Print range mCoples———
4l Mumber of copies: |1 3:

& Fages _|ic-rn-| 1‘-__1| o o
) : | 1 | 5 | 3 17 ozt
r Qﬁllff"llf-i'l 1 2 3
ok I Cancel |

2 Select the folder and assign a name of the file and then
click OK.

Basic Printing
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Printer Settings

You can use the printer properties window, which allows you to
access all of the printer options you need when using your
printer. When the printer properties are displayed, you can
review and change the settings needed for your print job.

Your printer properties window may differ, depending on your
operating system. This Software User’s Guide shows the
Properties window for Windows XP.

Your printer driver Properties window that appears in this
User’s Guide may differ depending on the printer in use.

If you access printer properties through the Printers folder, you
can view additional Windows-based tabs (refer to your
Windows User’s Guide) and the Printer tab (see “Printer Tab” on
page 16).

NOTES:

« Most Windows applications will override settings you specify
in the printer driver. Change all print settings available in the
software application first, and change any remaining settings
using the printer driver.

» The settings you change remain in effect only while you are
using the current program. To make your changes
permanent, make them in the Printers folder.

* The following procedure is for Windows XP. For other
Windows OS, refer to the corresponding Windows User's
Guide or online help.

Click the Windows Start button.

Select Printers and Faxes.

Select your printer driver icon.

Right-click on the printer driver icon and select

Printing Preferences.

Change the settings on each tab, click OK.

PONPE

@




Layout Tab

The Layout tab provides options to adjust how the document
appears on the printed page.

S ——— 8]
Layout ‘ Paper || Graphic | Estras | Abaut |
r— Paper Orientation
s EEECAEL
a  Landscape
[~ Riotate 180 Degrees
i~ Lapaut Option:
Lapout Type: IMuIt\pIe Pages per Side ;I
Pages per Side |1 - —_— .
Fages Order -
I =] =
I™ | Fiint Page Border 210% 297 mm
& mm " inch
Copies: 1
Reszolution: 0D dpi
Favoites————
IPHHlEI Default -
[elete
anmw

[

Paper Orientation

Paper Orientation allows you to select the direction in which

information is printed on a page.

* Portrait prints across the width of the page, letter style.

* Landscape prints across the length of the page, spreadsheet
style.

« Rotate allows you to rotate the page the selected degrees.

A Portrait A Landscape

Layout Options

Layout Options allows you to select advanced printing options.

You can choose Multiple Pages per Side and Poster Printing.

« For details, see “Printing Multiple Pages on One Sheet of Paper
(N-Up Printing)” on page 18.

* For details, see “Printing Posters” on page 19
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Paper Tab

Use the following options to set the basic paper handling
specifications when you access the printer properties. See
“Printing a Document” on page 12 for more information on
accessing printer properties.

Click the Paper tab to access various paper properties.

S - —
| Layﬂull Paper | Graphic | Extras | About |
Copies [1-993) 3:
Paper Optiohs
Size | Ad j
Custom
Source |Tray1 j -— el i i bk
Type [ Printer Defaul: | e .
Ad
210 % 297 mm
g Ll
Scaling Printing s feto
s Copies: 1
ELLOIT o Hovs El Resolulion: 600 dpi
rlERElcs——————
Frinter Default -I
Delete |
ELECTRONICS

Copies
Copies allows you to choose the number of copies to be printed.
You can select 1 to 999 copies.

Paper Options

Size

Size allows you to set the size of paper you loaded in the tray.

If the required size is not listed in the Size box, click Custom.
When the Custom Paper Setting window appears, set the paper
size and click OK. The setting appears in the list so that you can
select it.

Source
Make sure that Source is set to the corresponding paper tray.

Type

Set Type to correspond to the paper loaded in the tray from
which you want to print. This will let you get the best quality
printout. If not, print quality may not be acheived as you want.

Scaling Printing

Scaling Printing allows you to automatically or manually scale

your print job on a page. You can choose from None, Reduce/

Enlarge, and Fit to Page.

» For details, see “Printing a Reduced or Enlarged Document” on
page 19.

« For details, see “Fitting Your Document to a Selected Paper
Size” on page 19.



Graphics Tab

Use the following Graphic options to adjust the print quality for
your specific printing needs. See “Printing a Document” on
page 12 for more information on accessing printer properties.

Click the Graphic tab to display the properties shown below.

 E—— B x|

| Layout | Paper ‘ Graphic |Extras | About |

Resolution

O 1200 dpiBest)
S | ¢+ B dpi iHomali

Toner Save Mode
& Printer Setting

(oo™
&
" 0ff

(=3
)

Darkness &
gl & Momal 210% 257 mm
@I ¢ Light " mm " inch
" Dark Copies: 1
Resolution: E00 dpi
[ Favorites————————————
Frinter Default i
Advanced Options Delete
anum
2ovh
Resolution

The Resolution options you can select may vary
depending on your printer model. The higher the setting,
the sharper the clarity of printed characters and graphics. The
higher setting also may increase the time it takes to print a
document.

Toner Save Mode

Selecting this option extends the life of your toner cartridge and

reduces your cost per page without a significant reduction in print

quality. Some printers do not support this feature.

« Printer Setting: If you select this option, this feature is
determined by the setting you've made on the control panel of
the printer.

* On: Select this option to allow the printer to use less toner on
each page.

= Off: If you don’t need to save toner when printing a document,
select this option.

Darkness

Use this option to lighten or darken your print job. Some

printers do not support this feature.

« Normal: This setting is for normal documents.

« Light: This setting is for bolder line widths or darker gray-scale
images.

« Dark: This setting is for finer line width, higher definition in
graphics, and lighter gray-scale images.
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Advanced Options

You can set advanced settings by clicking the Advanced

Options button.

e Grayscale Enhancement: Grayscale Enhancement
allows users to preserve the details of nature photos, and
improve contrast and readability among gray-scaled colors,
when printing color documents in grayscale.

« Print All Text To Black: When the Print All Text To
Black option is checked, all text in your document prints solid
black, regardless of the color it appears on the screen.

e Print All Text to Darken: When the Print All Text to
Darken option is checked, all text in your document is allowed
to print darker than on a normal document.



Extras Tab

You can select output options for your document. See “Printing
a Document” on page 12 for more information about accessing
the printer properties.

Click the Extras tab to access the following feature:

Layout | Paper || Graphic| Estras | sbout
wiatemark
N0 '/ atermark] Edit
Qverlay
‘[No Overlay] j Edit
Output O ptions
Print Subset Reverse All Pages [3.21] =
Letter
8.50%11.00in
" mm *+ inch
Copies: 1
Resalution: 00 dpi
Favorites
Prirter Detault -
ELECTRONICS
o
Watermark

You can create a background text image to be printed on each
page of your document. For details, see “Using Watermarks” on
page 20.

Overlay
Overlays are often used to take the place of preprinted forms and
letterhead paper. For details, see “Using Overlays” on page 21.

Output Options
« Print Subset: You can set the sequence in which the pages
print. Select the print order from the drop-down list.
- Normal (1,2,3): Your printer prints all pages from the first
page to the last page.
- Reverse All Pages (3,2,1): When you use this feature,
you do not need to sort the print-out by stacks.
- Print Odd Pages: Your printer prints only the odd numbered
pages of the document.
- Print Even Pages: Your printer prints only the even
numbered pages of the document.
* Reprint When Jammed: When this option is checked, the
printer retains the image of a printed page until the printer
signals that the page has successfully exited the printer.
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About Tab

Use the About tab to display the copyright notice and the
version number of the driver. If you have an Internet browser,
you can connect to the Internet by clicking on the web site icon.
See “Printing a Document” on page 12 for more information
about accessing printer properties.

Printer Tab

If you access printer properties through the Printers folder,
you can view the Printer tab. You can set the printer
configuration.

The following procedure is for Windows XP. For other Windows
0S, refer to the corresponding Windows User's Guide or online
help.

1 Click the Windows Start menu.
Select Printers and Faxes.
Select your printer driver icon.

Properties.

2
3
4 Right-click on the printer driver icon and select
5 Click the Printer tab and set the options.



Using a Favorite Setting

The Favorites option, which is visible on each properties tab,
allows you to save the current properties settings for future
use.

To save a Favorites item:
1 cChange the settings as needed on each tab.
2 Enter a name for the item in the Favorites input box.

Copigs: 1
7 Zsuiution: GO0 dpi

Favorites
|Unlitled YI
Save |

|

ELECTRONICS

QK I Cancel | Apply | Help- |

3 Click Save.
When you save Favorites, all current driver settings are
saved.
To use a saved setting, select the item from the Favorites drop
down list. The printer is now set to print according to the
Favorites setting you selected.
To delete a Favorites item, select it from the list and click
Delete.

You can also restore the printer driver’s default settings by
selecting Printer Default from the list.

Basic Printing
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Using Help

Your printer has a help screen that can be activated by clicking
the Help button in the printer properties window. These help
screens give detailed information about the printer features
provided by the printer driver.

You can also click #] from the upper right corner of the window,
and then click on any setting.



Advanced Printing

This chapter explains printing options and advanced printing
tasks.

NOTE:

= Your printer driver Properties window that appears in this
User’s Guide may differ depending on the printer in use.
However the composition of the printer properties window is
similar.

= If you need to know the exact name of your printer, you can
check the supplied CD-ROM.

This chapter includes:

= Printing Multiple Pages on One Sheet of Paper (N-Up
Printing)

< Printing Posters

< Printing a Reduced or Enlarged Document

= Fitting Your Document to a Selected Paper Size
= Using Watermarks

< Using Overlays

Advanced Printing
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Printing Multiple Pages on One
Sheet of Paper (N-Up Printing)

You can select the number of pages to print on a single sheet
of paper. To print more than one page per sheet, the pages will
be reduced in size and arranged in the order you specify. You
can print up to 16 pages on one sheet.

1 To change the print settings from your software
application, access printer properties. See “Printing a
Document” on page 12.

2 From the Layout tab, choose Multiple Pages per Side in
the Layout Type drop-down list.

3 Select the number of pages you want to print per sheet
(1, 2, 4, 6, 9, or 16) in the Pages per Side drop-down
list.

4 Select the page order from the Page Order drop-down
list, if necessary.

Check Print Page Border to print a border around each
page on the sheet.

5 Click the Paper tab, select the paper source, size, and
type.

6 Click OK and print the document.
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Printing Posters

This feature allows you to print a single-page document onto 4,
9, or 16 sheets of paper, for the purpose of pasting the sheets
together to form one poster-size document.

1 To change the print settings from your software

application, access printer properties. See “Printing a
Document” on page 12.

2 Click the Layout tab, select Poster Printing in the
Layout Type drop-down list.
3 Configure the poster option:

You can select the page layout from Poster<2x2>,
Poster<3x3> or Poster<4x4=. If you select
Poster<2x2=, the output will be automatically stretched

to cover 4 physical pages.
N
w [
NV

A 2x2
A 3x3

Specify an overlap in millimeters or inches to make it
easier to pasting the sheets together.

ma ’Q“

,\4 2 A\‘

0.15 inches
|
\, \/ )

4 Click the Paper tab, select the paper source, size, and

type.

5 Click OK and print the document. You can complete the
poster by pasting the sheets together.

0.15 inches
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Printing a Reduced or Enlarged
Document

You can change the size of a page’s content to appear larger or
smaller on the printed page.
1 To change the print settings from your software

application, access printer properties. See “Printing a
Document” on page 12.

2 From the Paper tab, select Reduce/Enlarge in the
Printing Type drop-down list.
3 Enter the scaling rate in the Percentage input box.
You can also click the w or A button.
4 Select the paper source, size, and type in Paper Options.
5 click OK and print the document.

Fitting Your Document to a
Selected Paper Size

This printer feature allows you to scale your print job to any
selected paper size regardless of the digital document size. This
can be useful when you want to check fine details on a small
document.

1 To change the print settings from your software

application, access printer properties. See “Printing a
Document” on page 12.

From the Paper tab, select Fit to Page in the Printing
Type drop-down list.

Select the correct size from the Output size drop-down
list.

Select the paper source, size, and type in Paper Options.

ahsr W N

Click OK and print the document.



Using Watermarks

The Watermark option allows you to print text over an existing
document. For example, you may want to have large gray
letters reading “DRAFT” or “CONFIDENTIAL” printed diagonally
across the first page or all pages of a document.

There are several predefined watermarks that come with the
printer, and they can be modified, or you can add new ones to
the list.

Using an Existing Watermark

1 To change the print settings from your software
application, access printer properties. See “Printing a
Document” on page 12.

2 Click the Extras tab, and select the desired watermark
from the Watermark drop-down list. You will see the
selected watermark in the preview image.

3 Click OK and start printing.

NOTE: The preview image shows how the page will look when
it is printed.

Creating a Watermark

1 To change the print settings from your software
application, access printer properties. See “Printing a
Document” on page 12.

2 Click the Extras tab, and click the Edit button in the
Watermark section. The Edit Watermark window
appears.

3 Enter a text message in the Watermark Message box.
You can enter up to 40 characters. The message displays
in the preview window.

When the First Page Only box is checked, the watermark
prints on the first page only.

4 Select watermark options.

You can select the font name, style, size, or grayscale level
from the Font Attributes section and set the angle of the
watermark from the Message Angle section.

5 Click Add to add a new watermark to the list.

6 When you have finished editing, click OK and start
printing.

To stop printing the watermark, select (No Watermark) from

the Watermark drop-down list.

Advanced Printing
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Editing a Watermark

1 To change the print settings from your software
application, access printer properties. See “Printing a
Document” on page 12.

2 Click the Extras tab and click the Edit button in the
Watermark section. The Edit Watermark window
appears.

3 Select the watermark you want to edit from the Current
Watermarks list and change the watermark message and
options.

4 Click Update to save the changes.

5 Click OK until you exit the Print window.

Deleting a Watermark

1 To change the print settings from your software
application, access printer properties. See “Printing a
Document” on page 12.

2 From the Extras tab, click the Edit button in the
Watermark section. The Edit Watermark window
appears.

3 Select the watermark you want to delete from the Current
Watermarks list and click Delete.

4 Click OK until you exit the Print window.
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Using Overlays

What is an Overlay?

An overlay is text and/or images stored in the computer hard
disk drive (HDD) as a special file format that can be printed on
any document. Overlays are often used to take the place of
preprinted forms and letterhead paper. Rather than using
preprinted letterhead, you can create an overlay containing the
exact same information that is currently on your letterhead. To
print a letter with your company’s letterhead, you do not need
to load preprinted letterhead paper in the printer. You need only
tell the printer to print the letterhead overlay on your
document.

Creating a New Page Overlay

To use a page overlay, you must create a new page overlay
containing your logo or image.

1 Create or open a document containing text or an image for

use in a new page overlay. Position the items exactly as
you wish them to appear when printed as an overlay.

To save the document as an overlay, access printer
properties. See “Printing a Document” on page 12.

Click the Extras tab, and click Edit button in the Overlay
section.

In the Edit Overlay window, click Create Overlay.

ar W N

In the Create Overlay window, type a name of up to eight
characters in the File name box. Select the destination
path, if necessary. (The default is C:\Formover).

Click Save. The name appears on the Overlay List box.
Click OK or Yes to finish creating.

~N O

The file is not printed. Instead it is stored on your
computer hard disk drive.

NOTE: The overlay document size must be the same as the
documents you print with the overlay. Do not create an overlay
with a watermark.

Advanced Printing
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Using a Page Overlay

After an overlay has been created, it is ready to be printed with
your document. To print an overlay with a document:

1 Create or open the document you want to print.

2 To change the print settings from your software
application, access printer properties. See “Printing a
Document” on page 12.

3 Click the Extras tab.

4 Select the desired overlay from the Overlay drop-down
list box.
5 If the overlay file you want does not appear in the

Overlay list, click Edit button and Load Overlay, and
select the overlay file.

If you have stored the overlay file you want to use in an
external source, you can also load the file when you access
the Load Overlay window.

After you select the file, click Open. The file appears in the
Overlay List box and is available for printing. Select the
overlay from the Overlay List box.

6 If necessary, click Confirm Page Overlay When
Printing. If this box is checked, a message window
appears each time you submit a document for printing,
asking you to confirm your wish to print an overlay on your
document.

If this box is not checked and an overlay has been
selected, the overlay automatically prints with your
document.

7 Click OK or Yes until printing begins.

The selected overlay downloads with your print job and
prints on your document.

NOTE: The resolution of the overlay document must be the
same as that of the document you will print with the overlay.

Deleting a Page Overlay
You can delete page overlays that you no longer use.

In the printer properties window, click the Extras tab.
Click the Edit button in the Overlay section.

Select the overlay you want to delete from the Overlay
List box.

Click Delete Overlay.
When a confirming message window appears, click Yes.

ok WNEE

Click OK until you exit the Print window.



Sharing the Printer
Locally

You can connect the printer directly to a selected computer,
which is called “host computer,” on the network.

The following procedure is for Windows XP. For other Windows
0S, refer to the corresponding Windows User's Guide or online
help.

NOTES:

* Check the Operating System(s) that are compatible with
your printer. Please refer to the OS Compatibility section of
Printer Specifications in your Printer User’s Guide.

« If you need to know the exact name of your printer, you can
check the supplied CD-ROM.

Sharing the Printer Locally
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Setting Up a Host Computer

Start Windows.

From the Start menu select Printers and Faxes.
Double-click your printer driver icon.

From the Printer menu, select Sharing.

Check the Share this printer box.

Fill in the Shared Name field, and then click OK.

OO0 WNEPE

Setting Up a Client Computer

1 Right-click the Windows Start button and select Explore.

2 Select My Network Places and then right-click Search
for Computers.

3 Fillin the IP address of host computer in Computer name
field, and click Search. (In case host computer requires

User name and Password, fill in User ID and password
of host computer account.)

Double-click Printers and Faxes.
Right-click printer driver icon, select Connect.

(O)JN6) AN

Click Yes, if the installation confirm message appears.



Using Smart Panel

Smart Panel is a program that monitors and informs you of the
status of the printer, and allows you to customize the printer’s
settings. If you are a Windows or Macintosh OS user, Smart
Panel is installed automatically when you install the printer
software. If you are a Linux OS user, download Smart Panel
from the Samsung website (www.samsung.com/printer) and
install.

NOTES:
= To use this program, you need:

- To check for Operating System(s) that are compatible with
your printer, refer to Printer Specifications in your Printer
User’s Guide.

- Mac OS X 10.3 or higher

- Linux. To check for Linux systems that are compatible with
your printer, refer to Printer Specifications in your Printer
User’s Guide.

- Internet Explorer version 5.0 or higher for flash animation
in HTML Help.
= If you need to know the exact name of your printer, you can
check the supplied CD-ROM.

Understanding Smart Panel

If an error occurs while printing, Smart Panel appears
automatically, showing the error.

You can also launch Smart Panel manually. Double-click the
Smart Panel icon on the Windows task bar (in Windows), or
Notification Area (in Linux). You can also click it on the status
bar (in Mac OS X).

Double-click this icon in Windows.

&9, 11:09pM

Click this icon in Mac OS X.

A 4
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Click this icon in Linux.

L&

If you are a Windows user, from the Start menu, select
Programs or All Programs — your printer driver name —
Smart Panel.

NOTES:

< If you have already installed more than one Samsung
printer, first select the printer model you want in order to
use the corresponding Smart Panel. Right-click (in Windows
or Linux) or click (in Mac OS X) the Smart Panel icon and
select your printer name.

e The Smart Panel window and its contents shown in this
Software User’s Guide may differ depending on the printer or
Operating System in use.

The Smart Panel program displays the current status of the
printer, the level of toner remaining in the toner cartridge(s)
and various other information. You can also change settings.

Read :
v | % Buy Now
| ‘;‘I?[,ouhleshooﬁng Guide

5

X

| ,: '{:@Urimer Setting

| @ Drriver Setting

@ Toner Level

You can view the level of toner remaining in the toner
cartridge(s). The printer and the number of toner cartridge(s)
shown in the above window may differ depending on the printer in
use. Any printers do not have this feature.

Buy Now
You can order replacement toner cartridge(s) online.

Troubleshooting Guide
You can view Help to solve problems.

Printer Setting
You can configure various printer settings in the Printer Settings
Utility window. Any printers do not have this feature.



NOTE: If your machine is connected a network, the
SyncThru Web Service window appears instead of the
Printer Settings Utility window. This program is supported in
Windows, MAC OS X. But in Linux, it is supported only in
certain software, such as Internet Explorer 5.5 or higher,
Safari 1.3 or higher, Mozilla FireFox 1.5 or higher.

Driver Setting (Only for Windows)

You can use the printer properties window, which allows you to
access all of the printer options you need for using your
printer. For details, See “Printer Settings” on page 13.

Opening the Troubleshooting
Guide

Using the troubleshooting guide, you can view solutions for
error status problems.

Right-click (in Windows or Linux) or click (in Mac OS X) the
Smart Panel icon and select Troubleshooting Guide.

Using Printer Settings Utility

Using the Printer Settings Utility, you can configure and check

print settings.

1 Right-click the Smart Panel icon and select Printer
Setting.

2 Change the settings.

3 To send the changes to the printer, click the Apply button.

NOTES: If your printer is connected to a network, the
SyncThru Web Service window appears instead of the
Printer Settings Utility window.

Using Onscreen Help File

For more information about Printer Settings Utility, click @ .

Using Smart Panel
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Changing the Smart Panel
Program Settings

Right-click (in Windows or Linux) or click (in Mac OS X) the
Smart Panel icon and select Options. Select the settings you
want from the Options window.



Using Your Printer in
Linux

You can use your machine in a Linux environment.

This chapter includes:

= Getting Started

<= Installing the Unified Linux Driver

< Using SetlP program

= Using the Unified Driver Configurator
= Configuring Printer Properties

< Printing a Document

Getting Started

You need to download Linux software package from the
Samsung website (www.samsung.com/printer) to install the
printer softwares.

After the driver is installed on your Linux system, the driver
package allows you to monitor a number of machine devices via
fast ECP parallel ports and USB simultaneously.

The Unified Linux Driver package is supplied with a smart and
flexible installation program. You don't need to search for
additional components that might be necessary for the Unified
Linux Driver software: all required packages will be carried onto
your system and installed automatically; this is possible on a
wide set of the most popular Linux clones.

Using Your Printer in Linux
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Installing the Unified Linux
Driver

Installing the Unified Linux Driver

1 Make sure that you connect your machine to your
computer. Turn both the computer and the machine on.

2 When the Administrator Login window appears, type in
root in the Login field and enter the system password.

NOTE: You must log in as a super user (root) to install the
printer software. If you are not a super user, ask your system
administrator.

3 From the Samsung website, download and unpack the
Unified Linux Driver package to your computer.
4 Click the icon at the bottom of the desktop. When the
Terminal screen appears, type in:
[root@localhost root]#tar zxf [FilePath]/
UnifiedLinuxDriver.tar.gz[root@localhost root]#cd
[FilePath]/cdroot/Linux[root@localhost Linux]#./
install.sh

NOTE: If you do not use the graphical interface and failed to
install the software, you have to use the driver in the text
mode. Follow the steps 3 to 4, and then follow the instructions
on the terminal screen.

5 When the welcome screen appears, click Next.

ey Unified Linux Driver Installer

Welcome to the Unified Linux Driver
installation wizard!

This program will install all necessary software
for printers and MFP devices
Click Next to continue with the Setup program

Help Next = Cancel



6 When the installation is complete, click Finish.

Unified Linux Driver Installer

Unified Linux Driver is installed.
Please, re-logon your system for all the installation settings to take effect,

— User Registration
Do you want to register vourself a3 user of the
printer/MFP model you just installec?
Being registered you wil gain access to various
services.
[ *fes, | want to be registered as user

[ e | | [ Enisn

The installation program has added the Unified Driver
Configurator desktop icon and Samsung Unified Driver
group to the system menu for your convenience. If you
have any difficulties, consult the onscreen help that is
available through your system menu or can otherwise be
called from the driver package windows applications,
such as Unified Driver Configurator.
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Uninstalling the Unified Linux Driver

1 When the Administrator Login window appears, type in
root in the Login field and enter the system password.

NOTE: You must log in as a super user (root) to install the
printer software. If you are not a super user, ask your system
administrator.

2 Click the icon at the bottom of the desktop. When the
Terminal screen appears, type in:

[root@localhost root]#cd /opt/Samsung/mfp/uninstall/
[root@localhost uninstall]#./uninstall.sh

3 Click Uninstall.
4 Click Next.

Uninstallation of Unified Linux Driver

“You are about te wninstall the Unified Linux Driver.

Press Mext to proceed with uninstaling the criver

Press Cancel o leawe the driver intact.

T () e

5 Click Finish.



Using SetlP program

This program is for the network IP setting using the MAC
address which is the hardware serial number of the network
printer card or interface. Especially, it is for the network
administrator to set several network IPs at the same time.

You can only use SetlP program when your machine is
connected to a network.

SetlP program should be automatically installed during the
printer driver installation.

Starting the program

1 Print the machine’s network information report which
includes your machine’s MAC address.

Open the Zopt/Samsung/mfp/share/utils/.
Double click the SetlPApplet.html file.

A WON

Click %% in the SetlP window to open the TCP/IP
configuration window.

Enter the network card's MAC address, IP address, subnet
mask, default gateway, and then click Apply.

ol

NOTE: when you enter the MAC address, enter it without colon(:).

6 The machine prints the network information. Confirm all
the settings are correct.
7 Close the SetlP program.

Using Your Printer in Linux
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Printers Configuration button —0@ =
FRefresh
Ports Configuration button —g@ ® Je—

Using the Unified Driver
Configurator

Unified Linux Driver Configurator is a tool primarily intended for
configuring Printer.

After installing the Unified Linux driver, the Unified Linux Driver
Configurator icon will automatically be created on your desktop.

Opening the Unified Driver

Configurator

1 Double-click Unified Driver Configurator on the
desktop.

You can also click the Startup Menu icon and select
Samsung Unified Driver and then Unified Driver
Configurator.

2 Press each button on the Modules pane to switch to the
corresponding configuration window.

Unified Driver Configurator

~ Printers

Removve Printer

Set oz Default
Stop
Test.

Praperties.

Hhout

P

Heo

(~ Belected printer:
Localprivter(ide)
Mode

UFR.

aiTws

You can use the onscreen help by clicking Help.
3 After changing the configurations, click Exit to close the
Unified Driver Configurator.



Printers Configuration

Printers configuration has the two tabs: Printers and Classes.

Printers Tab

You can see the current system’s printer configuration by
clicking on the printer icon button on the left side of the Unified
Driver Configurator window.

Switches to Printer = (e L]
configuration. | @ e
% 4 e Frnites
nird Privder
&= | shows all of the e
installed printer. pr
Teat.
P fie:
Aot
Hele
Shows the status, T
model name and bl

URI of your printer.

You can use the following printer control buttons:
* Refresh: renews the available printers list.

Add Printer: allows you to add a new printer.

Remove Printer: removes the selected printer.

Set as Default: sets the current printer as a default
printer.

« Stop/Start: stops/starts the printer.

- Test: allows you to print a test page to check if the
machine is working properly.

= Properties: allows you to view and change the printer
properties. For details, see page 29.
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Classes Tab
The Classes tab shows a list of available printer classes.

Unified Driver Configurator

— Printers conigurati

Frinters | Classes
S
' Refresh
Remave Class

Shows all of the
printer classes. stop

Properties

Ahout

BT

Help

Shows the status of the
class and the number of

Selected class:
ﬁﬁ?n'fm — printers in the class.
— J
il

* Refresh : Renews the classes list.
* Add Class... : Allows you to add a new printer class.
< Remove Class : Removes the selected printer class.

Ports Configuration

In this window, you can view the list of available ports, check
the status of each port and release a port that is stalled in busy
state when its owner is terminated for any reason.

Unified Driver Configurator

—Fort
lelew
ddevimfpl Jdevimifpl  Jfdevimfp2  Jdevimfp3 EEERENCLE

E IdevimipS devimips fdevimfn? fdevimips Jdevimipd Help

| ®

w0 - Shows all of the
available ports.

Switches to
ports
configuration.

Shows the port type,
device connected to
the port and status Fﬂff‘.ii:uﬁss -

Part is unused

il

= Refresh : Renews the available ports list.
= Release port : Releases the selected port.



Configuring Printer Properties

Using the properties window provided by the Printers
configuration, you can change the various properties for your
machine as a printer.

1 Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.
2 Select your machine on the available printers list and click
Properties.
3 The Printer Properties window opens.

Printer Properties

General {Eﬂnnectmn ‘Driver |Jnhs ‘Elasses ]

Marng

Location:

Printing a Document

Printing from Applications

There are a lot of Linux applications that you are allowed to
print from using Common UNIX Printing System (CUPS). You
can print on your machine from any such application.

1 From the application you are using, select Print from the
File menu.

2 Select Print directly using lpr.

3 In the LPR GUI window, select the model name of your
machine from the Printer list and click Properties.

(— Printer

( =) [ e Click,

Stadus: idle, accepting iohs

Description

A

The following five tabs display at the top of the window:

=General: allows you to change the printer location and
name. The name entered in this tab displays on the
printer list in Printers configuration.

«Connection: allows you to view or select another port. If
you change the printer port from USB to parallel or vice
versa while in use, you must re-configure the printer port
in this tab.

<Driver: allows you to view or select another printer
driver. By clicking Options, you can set the default
device options.

«Jobs: shows the list of print jobs. Click Cancel job to
cancel the selected job and select the Show completed
jobs check box to see previous jobs on the job list.

«Classes: shows the class that your printer is in. Click

Location:

Description:

N

Set as Default

~Fage Selection
(@) Al pages

() Even pages
() Dol pages

— Cop
Copies [1~100]

) Some pages: [

y (=
[

commaz (1,2-5,10-12,17).

Enter page numbers ancior groups of pages to print separated by \. . . ’
173 \ 1 1 ’

4

*Reverse All Pages(3,2,1): When you use this feature,
you do not need to sort the print-out by stacks.

4 Change the printer

&

and print job properties.

Properties

Add to Class to add your printer to a specific class or
click Remove from Class to remove the printer from the
selected class.

4 Click OK to apply the changes and close the Printer
Properties Window.

29
Using Your Printer in Linux

General | Test | Graphics | Device
~ Paper Option:
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Paper Orientation ————————————————————— —
@ Fartrait @
® I o)
[ Feverse? O
B ~ Pages per Side [N-Up}——————
® -4
B fwone [+]|| Ozw
O 4-Up



The following four tabs display at the top of the window.

«General - allows you to change the paper size, the paper
type, and the orientation of the documents, enables the
duplex feature, adds start and end banners, and changes
the number of pages per sheet.

«Text - allows you to specify the page margins and set the
text options, such as spacing or columns.

«Graphics - allows you to set image options that are used
when printing images/files, such as color options, image
size, or image position.

Device: allows you to set the print resolution, paper
source, and destination.

5 click Apply to apply the changes and close the Properties
window.

6 Click OK in the LPR GUI window to start printing.

7 The Printing window appears, allowing you to monitor the
status of your print job.

To abort the current job, click Cancel.

Printing Files

You can print many different types of files on the Samsung

machine device using the standard CUPS way - directly from

the command line interface. The CUPS Ipr utility allows you do

that. But the drivers package replaces the standard Ipr tool by

a much more user-friendly LPR GUI program.

To print any document file:

1 Type Ipr <file_name=> from the Linux shell command
line and press Enter. The LPR GUI window appears.

When you type only Ipr and press Enter, the Select
file(s) to print window appears first. Just select any files
you want to print and click Open.

2 In the LPR GUI window, select your printer from the list,
and change the printer and print job properties.

For details about the properties window, see page 29.
3 Click OK to start printing.
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Using Your Printer with
a Macintosh

Your printer supports Macintosh systems with a built-in USB
interface or 10/100 Base-TX network interface card. When you
print a file from a Macintosh computer, you can use the CUPS driver
by installing the PPD file.

NOTE: Some printers do not support a network
interface. Make sure that your printer supports a
network interface by referring to Printer Specifications
in your Printer User’s Guide.

This chapter includes:

< Installing Software

< Uninstalling software
< Using SetlP program

= Setting Up the Printer
< Printing

Installing Software

The CD-ROM that came with your printer provides you with the
PPD file that allows you to use the CUPS driver or Apple
LaserWriter driver (only available when you use a printer
which supports the PostScript driver), for printing on a
Macintosh computer.

Installing the Printer driver

Make sure that you connect your printer to the computer.
Turn on your computer and printer.

Insert the CD-ROM which came with your printer into the
CD-ROM drive.

Double-click CD-ROM icon that appears on your
Macintosh desktop.

Double-click the MAC _Installer folder.

Double-click the Installer icon.

Enter the password and click OK.

The Samsung Installer window opens. Click Continue
Select Easy Install and click Install. Easy Install is
recommended for most users. All components necessary
for printer operations will be installed.

If you select Custom Install, you can choose individual
components to install.

9 The message which warns all application will close on your
computer appears, Click Continue.

o~NoOOhr~ W N P
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10 select Typical installation for a local printer and then
click OK.

NOTE: If you select Typical installation for a network
printer, see “Using SetlP program” on page 32 after the
installation is finished.

11 After the installation is finished, click Quit.

NOTE: After the installation is finished, see “Setting Up the
Printer” on page 32

Uninstalling software

Uninstall is required if you are upgrading the software, or if
installation fails.

1 Make sure that you connect your printer to the computer.
Turn on your computer and printer.

Insert the CD-ROM which came with your printer into the
CD-ROM drive.

Double-click CD-ROM icon that appears on your
Macintosh desktop.

Double-click the MAC_Installer folder.

Double-click the Installer icon.

Enter the password and click OK.

The Samsung Installer window opens. Click Continue
Select Uninstall and click Uninstall.

Co~NOUOA~ W N

When the uninstallation is done, click Quit.
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Using SetlP program

This program is for the network IP setting using the MAC
address which is the hardware serial number of the network
printer card or interface. Especially, it is for the network
administrator to set several network IPs at the same time.

You can only use SetlP program when your machine is
connected to a network.

SetlP program should be automatically installed during the
printer driver installation.

NOTE: If you select Typical installation for a network
printer during the printer driver installation, the SetIP
program automatically runs after the installation. Follow the
below instruction.

1 The certificate window appears, click Trust.

2 Print the machine’s network information report which
includes your machine’s MAC address.

3 Click £} in the SetIP window to open the TCP/IP
configuration window.
4  Enter the network card's MAC address, IP address, subnet

mask, default gateway, and then click Apply.
when you enter the MAC address, enter it without colon(:).

5 The machine prints the network information. Confirm all
the settings are correct.
6 Close the SetlP program.

Starting the program

If you want to change your network printer IP setting, follow
the below instruction.

1 Print the machine’s network information report which
includes your machine’s MAC address.

Open the Library folder —» Printers - Samsung — Your
printer model name — SetlP.

Double click the SetlPApplet.html file.

When a certificate window appears, click Trust.

Click £} in the SetlP window to open the TCP/IP
configuration window.
Enter the network card's MAC address, IP address, subnet

mask, default gateway, and then click Apply.
when you enter the MAC address, enter it without colon(:).

The machine prints the network information. Confirm all
the settings are correct.
Close the SetlP program.

o a w0 N
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Setting Up the Printer
Set up for your printer will be different depending on which

cable you use to connect the printer to your computer—the
network cable or the USB cable.

For a Network-connected

NOTE: Some printers do not support a network
interface. Before connecting your printer, make sure
that your printer supports a network interface by
referring to Printer Specifications in your Printer User’s
Guide.

1 Follow the instructions on “Installing Software” on page 31
to install the PPD and Filter files on your computer.

2 Open the Applications folder — Utilities, and Print
Setup Utility.
«For MAC OS 10.5~10.6, open System Preferences from
the Applications folder, and click Print & Fax.

3 Click Add on the Printer List.

eFor MAC OS 10.5~10.6, press the “+” icon then a display
window will pop up.

4 For MAC OS 10.3, select the IP Printing tab.

eFor MAC OS 10.4, click IP Printer.
*For MAC OS 10.5~10.6, click IP.

5 Select Socket/HP Jet Direct in Printer Type.
WHEN PRINTING A DOCUMENT CONTAINING MANY
PAGES, PRINTING PERFORMANCE MAY BE
ENHANCED BY CHOOSING SOCKET FOR PRINTER
TYPE OPTION.

6 Enter the printer’s IP address in the Printer Address
field.

7 Enter the queue name in the Queue Name field. If you
cannot determine the queue name for your printer server,
try using the default queue first.

8 For MAC OS 10.3, if Auto Select does not work properly,
select Samsung in Printer Model and your printer
name in Model Name.

eFor MAC OS 10.4, if Auto Select does not work properly,
select Samsung in Print Using and your printer name
in Model.

«For MAC OS 10.5~10.6, if Auto Select does not work
properly, select Select a driver to use... and your
printer name in Print Using.

Your printer’s IP address appears on the Printer List, and
is set as the default printer.

9 Click Add

Using Your Printer with a Macintosh



For a USB-connected

1 Follow the instructions on “Installing Software” on page 31
to install the PPD and Filter files on your computer.

2 Open the Applications folder — Utilities, and Print
Setup Utility.
«For MAC OS 10.5~10.6, open System Preferences from
the Applications folder, and click Print & Fax.
3 Click Add on the Printer List.
«For MAC OS 10.5~10.6, press the “+” icon then a display
window will pop up.
4 For MAC OS 10.3, select the USB tab.

eFor MAC OS 10.4, click Default Browser and find the
USB connection.

eFor MAC OS 10.5~10.6, click Default and find the USB
connection.

5 Select Samsung in Printer Model and your printer in
Model Name.
6 Click Add.

Your printer appears on the Printer List, and is set as the
default printer.
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Printing

NOTES:

* The Macintosh printer’s properties window that appears in
this User’s Guide may differ depending on the printer in use.
However the composition of the printer properties window is
similar.

= You can check your printer name in the supplied CD-
ROM.

Printing a Document

When you print with a Macintosh, you need to check the printer
software setting in each application you use. Follow these steps
to print from a Macintosh.

1 Open a Macintosh application and select the file you want
to print.

2 Open the File menu and click Page Setup (Document
Setup in some applications).

3 Choose your paper size, orientation, scaling, and other
options and click OK.

Settings: __Page Attributes g l

Format for: J ,J

— Make sure that your

Paper Size: | USLetter  printer is selected.
21.59em  _

Orientation: ||| | ]l LS

Scale: 100 %

(j} l.: Cancel ) ( 0K )

A Mac OS 10.3

4 Open the File menu and click Print.

5 Choose the number of copies you want and indicate which
pages you want to print.

6 Click Print when you finish setting the options.
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Changing Printer Settings

You can use advanced printing features when using your
printer.

From your Macintosh application, select Print from the File
menu. The printer name which appears in the printer properties
window may differ depending on the printer in use. Except for
the name, the composition of the printer properties window is
similar.

NOTES: The setting options may differ depending on printers
and Macintosh OS version.

Layout

The Layout tab provides options to adjust how the document
appears on the printed page. You can print multiple pages on
one sheet of paper. Select Layout from the Presets drop-down
list to access the following features.

Printer:

ar

ar

Presets:  Standard

ar

Layout }

Pages per Sheet: 1 F

Layout Direction: |~

[
Border: | None =

e
K3

£5

@ (CroFv ) (Preview ) (Cancel ) (Prine)

A Mac OS 10.4

e Pages per Sheet: This feature determines how many
pages printed on one page. For details, see "Printing
Multiple Pages on One Sheet of Paper" on the next column.

< Layout Direction: You can select the printing direction on
a page as like the examples on Ul.

Graphics

The higher the setting, the sharper the clarity of printed characters
and graphics. The higher setting also may increase the time it
takes to print a document.

Paper

Set Paper Type to correspond to the paper loaded in the tray
from which you want to print. This will let you get the best
quality printout. If you load a different type of print material,
select the corresponding paper type.



Printing Multiple Pages on One Sheet
of Paper

You can print more than one page on a single sheet of paper.

This feature provides a cost-effective way to print draft pages.

1 From your Macintosh application, select Print from the
File menu.

2 Select Layout.

Printer: |

“r

Presets: Standard

ar

Layout |
Pages per Sheat: | ]
)

1 Layout Direction: E‘ ‘EE‘ E‘*‘

Border: Non e ]

&

G} \\; Preview\,l l“ Save As PDF... .',l |"' Fax... 1 |"' Cancel .;l
A Mac 0S 10.3

3 Select the number of pages you want to print on one sheet
of paper on the Pages per Sheet drop-down list.

4 Select the page order from the Layout Direction option.
To print a border around each page on the sheet, select
the option you want from the Border drop-down list.

5 Click Print, and the printer prints the selected number of
pages on one side of each page.
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SOFTWARE SECTION

INDEX

A

advanced printing, use 18

D

document, print
Macintosh 34
Windows 12

E

Extras properties, set 16

F

favorites settings, use 17

G
Graphics properties, set 15

H
help, use 17

install
printer driver

Macintosh 31
Windows 4
installing

Linux software 25

L

Layout properties, set
Windows 14

Linux
driver, install 25
printer properties 29
printing 29

M

Macintosh
driver
install 31
uninstall 31
printing 34
setting up the printer 32
MFP driver, install
Linux 25

N

n-up printing
Macintosh 35
Windows 18

O

orientation, print 30
Windows 14
overlay
create 21
delete 21
print 21

P

Paper properties, set 14

paper size, set 14
print 30

paper source, set 30
Windows 14

paper type, set
print 30

poster, print 19

print
document 12
fit to page 19
from Macintosh 34
from Windows 12
N-up

Macintosh 35

Windows 18
overlay 21
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poster 20
PRN 13
scaling 19
watermark 20
print resolution 30
printer driver, install
Linux 25
printer properties
Linux 29
printer properties, set
Macintosh 34
Windows 13
printer resolution, set
Windows 15
printer software
install

Macintosh 31
Windows 4
uninstall

Macintosh 31
Windows 11
printing
from Linux 29

R

resolution
printing 30

S

setting
darkness 15
favorites 17
image mode 15
resolution

Windows 15
toner save 15

true-type option 15
software
install

Macintosh 31
Windows 4
reinstall

Windows 11



system requirements

Macintosh 31
uninstall

Macintosh 31
Windows 11
status monitor, use 23

T

toner save, set 15

U

uninstall, software
Macintosh 31
Windows 11
uninstalling
MFP driver
Linux 26

w

watermark
create 20
delete 20
edit 20
print 20
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